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【はじめに】

本文書は、

プロトコルである。

に観察

察条件、画像解析について、複数の機関による検討を通して、現状、良いと考えられる方法、条

件をのせている。前半に、重要なポイントを整理し、できるだけ多くの事例をのせて、その方法、条

件にした根拠がわかるようにした。さらに、参考にしてもらえるよう、より

た。これまでの検討結果を基に、推奨すべきプロトコをまとめた。用いたナノ粒子は、シリカ、チタ

ニアであるが、これに特化したものでなく、他のナノ粒子にも適用可能と考えている。

 なお試料調整法に関してはナノ粒子が適度に分散された試料を用いることを前提としており、試

料を観察用基板にセットする際に粒子が再凝集しないような調整法をプロトコルの対象とした。従

って分散状態の良い試料調整法には別途、十分な注意が必要である。

 

1.背景

ナノスケールオーダーで構造や特性を制御したナノ材料や、物質・材料の機能を飛躍的に向

上させるナノ製造技術の研究開発等が次世代産業の中核を担う基盤材料・技術として期待さ

れているが、物質としての安全性等については十分に確認されていない。ナノ材料安全管理の

必要性から、

する製品について規制が開始されている。

以下のように勧告された。

「ナノマテリアルとは、非結合状態、または強凝集体

この定義は工業製品がナノ材料であるかどうかの該非判定に用いられることから，いかに粒

子の

また、

「およそ

と定義されている。

フランス等でナノ材料の登録制度や表示の義務化（ナノラベリング）が開始され、

いては安全性試験のテストガイドライン策定の動

品の粒子サイズ分布の統一された測定法がない。

ナノ材料の観察・計測技術の一つに挙げられる

できることから産業界で広く普及している手法である。そこで、

産業技術総合研究所（産総研）とナノテクノロジービジネス推進協議会

業省委託事業である政府戦略分野に係る国際標準開発活動の一環で

測定法に関する国際標準

【はじめに】 

本文書は、1nm

プロトコルである。

に観察できることから

察条件、画像解析について、複数の機関による検討を通して、現状、良いと考えられる方法、条

件をのせている。前半に、重要なポイントを整理し、できるだけ多くの事例をのせて、その方法、条

件にした根拠がわかるようにした。さらに、参考にしてもらえるよう、より

た。これまでの検討結果を基に、推奨すべきプロトコをまとめた。用いたナノ粒子は、シリカ、チタ

ニアであるが、これに特化したものでなく、他のナノ粒子にも適用可能と考えている。

なお試料調整法に関してはナノ粒子が適度に分散された試料を用いることを前提としており、試

料を観察用基板にセットする際に粒子が再凝集しないような調整法をプロトコルの対象とした。従

って分散状態の良い試料調整法には別途、十分な注意が必要である。

背景  

ナノスケールオーダーで構造や特性を制御したナノ材料や、物質・材料の機能を飛躍的に向

上させるナノ製造技術の研究開発等が次世代産業の中核を担う基盤材料・技術として期待さ

れているが、物質としての安全性等については十分に確認されていない。ナノ材料安全管理の

必要性から、EU

する製品について規制が開始されている。

以下のように勧告された。

「ナノマテリアルとは、非結合状態、または強凝集体

レート)であり、個数濃度のサイズ分布で

ら 100nm のサイズ範囲である粒子を含む、自然の、または偶然にてできた、または製造さ

れた材料を意味する。」

この定義は工業製品がナノ材料であるかどうかの該非判定に用いられることから，いかに粒

子の粒子径分布を計測するかが

また、ISO TS80004

「およそ 1nm～

に、この長さの範囲に現れる。」

と定義されている。

フランス等でナノ材料の登録制度や表示の義務化（ナノラベリング）が開始され、

いては安全性試験のテストガイドライン策定の動

品の粒子サイズ分布の統一された測定法がない。

ナノ材料の観察・計測技術の一つに挙げられる

できることから産業界で広く普及している手法である。そこで、

産業技術総合研究所（産総研）とナノテクノロジービジネス推進協議会

業省委託事業である政府戦略分野に係る国際標準開発活動の一環で

測定法に関する国際標準
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1nm から 100nm

プロトコルである。SEM に着眼したのは

できることから産業界で広く普及している手法

察条件、画像解析について、複数の機関による検討を通して、現状、良いと考えられる方法、条

件をのせている。前半に、重要なポイントを整理し、できるだけ多くの事例をのせて、その方法、条

件にした根拠がわかるようにした。さらに、参考にしてもらえるよう、より

た。これまでの検討結果を基に、推奨すべきプロトコをまとめた。用いたナノ粒子は、シリカ、チタ

ニアであるが、これに特化したものでなく、他のナノ粒子にも適用可能と考えている。

なお試料調整法に関してはナノ粒子が適度に分散された試料を用いることを前提としており、試

料を観察用基板にセットする際に粒子が再凝集しないような調整法をプロトコルの対象とした。従

って分散状態の良い試料調整法には別途、十分な注意が必要である。

ナノスケールオーダーで構造や特性を制御したナノ材料や、物質・材料の機能を飛躍的に向

上させるナノ製造技術の研究開発等が次世代産業の中核を担う基盤材料・技術として期待さ

れているが、物質としての安全性等については十分に確認されていない。ナノ材料安全管理の

EU ではナノ粒子のサイズ分布に基づき「ナノ材料」が定義され、この定義に該当

する製品について規制が開始されている。

以下のように勧告された。 

「ナノマテリアルとは、非結合状態、または強凝集体

あり、個数濃度のサイズ分布で

のサイズ範囲である粒子を含む、自然の、または偶然にてできた、または製造さ

れた材料を意味する。」 

この定義は工業製品がナノ材料であるかどうかの該非判定に用いられることから，いかに粒

分布を計測するかが

TS80004-1 及び

～100nm の範囲

この長さの範囲に現れる。」

と定義されている。 

フランス等でナノ材料の登録制度や表示の義務化（ナノラベリング）が開始され、

いては安全性試験のテストガイドライン策定の動

品の粒子サイズ分布の統一された測定法がない。

ナノ材料の観察・計測技術の一つに挙げられる

できることから産業界で広く普及している手法である。そこで、

産業技術総合研究所（産総研）とナノテクノロジービジネス推進協議会

業省委託事業である政府戦略分野に係る国際標準開発活動の一環で

測定法に関する国際標準化を実施し
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100nm 以下のナノ粒子を対象にした

に着眼したのはナノ材料の観察・計測技術の一つに挙げられ

産業界で広く普及している手法

察条件、画像解析について、複数の機関による検討を通して、現状、良いと考えられる方法、条

件をのせている。前半に、重要なポイントを整理し、できるだけ多くの事例をのせて、その方法、条

件にした根拠がわかるようにした。さらに、参考にしてもらえるよう、より

た。これまでの検討結果を基に、推奨すべきプロトコをまとめた。用いたナノ粒子は、シリカ、チタ

ニアであるが、これに特化したものでなく、他のナノ粒子にも適用可能と考えている。

なお試料調整法に関してはナノ粒子が適度に分散された試料を用いることを前提としており、試

料を観察用基板にセットする際に粒子が再凝集しないような調整法をプロトコルの対象とした。従

って分散状態の良い試料調整法には別途、十分な注意が必要である。

ナノスケールオーダーで構造や特性を制御したナノ材料や、物質・材料の機能を飛躍的に向

上させるナノ製造技術の研究開発等が次世代産業の中核を担う基盤材料・技術として期待さ

れているが、物質としての安全性等については十分に確認されていない。ナノ材料安全管理の

ではナノ粒子のサイズ分布に基づき「ナノ材料」が定義され、この定義に該当

する製品について規制が開始されている。

 

「ナノマテリアルとは、非結合状態、または強凝集体

あり、個数濃度のサイズ分布で

のサイズ範囲である粒子を含む、自然の、または偶然にてできた、または製造さ

 

この定義は工業製品がナノ材料であるかどうかの該非判定に用いられることから，いかに粒

分布を計測するかが課題となっている。

及び JIS TSZ0030

の範囲、注記：より大きなサイズの外挿からは予測されない特性が

この長さの範囲に現れる。」 

フランス等でナノ材料の登録制度や表示の義務化（ナノラベリング）が開始され、

いては安全性試験のテストガイドライン策定の動

品の粒子サイズ分布の統一された測定法がない。

ナノ材料の観察・計測技術の一つに挙げられる

できることから産業界で広く普及している手法である。そこで、

産業技術総合研究所（産総研）とナノテクノロジービジネス推進協議会

業省委託事業である政府戦略分野に係る国際標準開発活動の一環で

化を実施した。
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以下のナノ粒子を対象にした

ナノ材料の観察・計測技術の一つに挙げられ

産業界で広く普及している手法であることがその理由である。

察条件、画像解析について、複数の機関による検討を通して、現状、良いと考えられる方法、条

件をのせている。前半に、重要なポイントを整理し、できるだけ多くの事例をのせて、その方法、条

件にした根拠がわかるようにした。さらに、参考にしてもらえるよう、より

た。これまでの検討結果を基に、推奨すべきプロトコをまとめた。用いたナノ粒子は、シリカ、チタ

ニアであるが、これに特化したものでなく、他のナノ粒子にも適用可能と考えている。

なお試料調整法に関してはナノ粒子が適度に分散された試料を用いることを前提としており、試

料を観察用基板にセットする際に粒子が再凝集しないような調整法をプロトコルの対象とした。従

って分散状態の良い試料調整法には別途、十分な注意が必要である。

ナノスケールオーダーで構造や特性を制御したナノ材料や、物質・材料の機能を飛躍的に向

上させるナノ製造技術の研究開発等が次世代産業の中核を担う基盤材料・技術として期待さ

れているが、物質としての安全性等については十分に確認されていない。ナノ材料安全管理の

ではナノ粒子のサイズ分布に基づき「ナノ材料」が定義され、この定義に該当

する製品について規制が開始されている。2011 年 10

「ナノマテリアルとは、非結合状態、または強凝集体

あり、個数濃度のサイズ分布で 50%以上の粒子について

のサイズ範囲である粒子を含む、自然の、または偶然にてできた、または製造さ

この定義は工業製品がナノ材料であるかどうかの該非判定に用いられることから，いかに粒

となっている。 

JIS TSZ0030-1（用語規格）

より大きなサイズの外挿からは予測されない特性が

フランス等でナノ材料の登録制度や表示の義務化（ナノラベリング）が開始され、

いては安全性試験のテストガイドライン策定の動きが始まっている。その一方で、工業粉体製

品の粒子サイズ分布の統一された測定法がない。 

ナノ材料の観察・計測技術の一つに挙げられる SEM

できることから産業界で広く普及している手法である。そこで、

産業技術総合研究所（産総研）とナノテクノロジービジネス推進協議会

業省委託事業である政府戦略分野に係る国際標準開発活動の一環で
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ナノスケールオーダーで構造や特性を制御したナノ材料や、物質・材料の機能を飛躍的に向

上させるナノ製造技術の研究開発等が次世代産業の中核を担う基盤材料・技術として期待さ
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この定義は工業製品がナノ材料であるかどうかの該非判定に用いられることから，いかに粒
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状やサイズなどを解析して分布を導出する。そのためには、粒子の部分と背景との明るさが明

確に分かれているコントラストが確保された画像が必要となる。また、明るさの差だけで粒子と

背景を区別するアルゴリズムでは粒子同士が重
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画像のコントラストや粒子の重なりの問題については画像解析ソフトである程度は補正する

ことができるが、完全な補正はできないので、できるだけ試料調整や

て理想に近い

るさの差（コントラスト）が明確で、粒子部分の明るさ（輝度）がそろっていて、個々の粒子がお互

いに接することがない（凝集のない、分散された）画像である（図１）。

ただ、粒子の形状や表面の性状により、また、

輝度を完全に一

に試料を調整することもできない。そのために、画像解析ソフトウェアには平滑化処理などの前

処理や重なった粒子を画像上で分離するセグメンテーションなどの補正は必要である。
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・試料調製により、上記

 ・SEM 画像は、粒子とバックグランドの差が大きく、粒子内は一様な明コントラストに

なるよう観察条件を決める。

 

SEM による粒子径分布計測のフローは図２のように三段階に分類される。
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るさの差（コントラスト）が明確で、粒子部分の明るさ（輝度）がそろっていて、個々の粒子がお互

いに接することがない（凝集のない、分散された）画像である（図１）。
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4. プロトコルの検討

ナノ粒子粒子径分布計測のプロトコルの検討にあたって、

を行うことにした。

シリカナノ粒子は、形状が球状に近く、分散性が比較的良い。ただし、シリカの試料液を基板

に滴下して乾燥させようとするとシリカ粒子が基板に固定されないため分散媒の蒸発に伴い粒

子が凝集してしまう。一方、チタニアは、形状が複雑で、凝集性が強い扱いにくい試料である。
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乾燥条件も影響する。

が凝集なく、分散している状態をつくること

2. SEM 観察フロー

次に基板を SEM

野を選定する。また、画像は、

部分が一様な明コントラスト

3. 画像解析フロー

画像を取得後、

バックグランド処理

プロトコルの検討

ナノ粒子粒子径分布計測のプロトコルの検討にあたって、

を行うことにした。

シリカナノ粒子は、形状が球状に近く、分散性が比較的良い。ただし、シリカの試料液を基板

に滴下して乾燥させようとするとシリカ粒子が基板に固定されないため分散媒の蒸発に伴い粒

子が凝集してしまう。一方、チタニアは、形状が複雑で、凝集性が強い扱いにくい試料である。
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(1) 試料調製フロー

① ナノ粒子分散液の準備

② 基板の前処理

③ 基板への分散液の滴下

(3) 画像解析フロー

① 解析準備（使用画像の選択、解析ソフトの準備）

② 画像前処理

③ セグメンテーション

④ 画像２値化

(2) SEM 観察フロー

① SEM

② SEM

試料調製フロー 

では計測の対象となるナノ粒子は既に分散と濃度調整がされた試料が準備されてい

ることを前提とした。ナノ粒子を固定する基板は、

使用する。分散液を基板に滴下し、乾燥させる。滴下後

いよう調整することがポイントになる。

条件も影響する。目標とする観察試料は

分散している状態をつくること

観察フロー 

SEM の試料台に固定し、観察する。

選定する。また、画像は、

が一様な明コントラスト

画像解析フロー 

画像を取得後、使用画像を選択する。画像処理、解析に用いるソフトは

バックグランド処理後、画像の２値化、輪郭

プロトコルの検討 

ナノ粒子粒子径分布計測のプロトコルの検討にあたって、

を行うことにした。RRT の試料にはチタニア（

シリカナノ粒子は、形状が球状に近く、分散性が比較的良い。ただし、シリカの試料液を基板

に滴下して乾燥させようとするとシリカ粒子が基板に固定されないため分散媒の蒸発に伴い粒

子が凝集してしまう。一方、チタニアは、形状が複雑で、凝集性が強い扱いにくい試料である。
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試料調製フロー 

ナノ粒子分散液の準備

基板の前処理 

基板への分散液の滴下

画像解析フロー 

解析準備（使用画像の選択、解析ソフトの準備）

画像前処理 

セグメンテーション

画像２値化 

観察フロー 

SEM 観察条件だし、視野選定

SEM 観察、画像取得

では計測の対象となるナノ粒子は既に分散と濃度調整がされた試料が準備されてい

ナノ粒子を固定する基板は、

分散液を基板に滴下し、乾燥させる。滴下後

ポイントになる。分散の良い状態

目標とする観察試料は

分散している状態をつくること

の試料台に固定し、観察する。

選定する。また、画像は、バックグランド（基板）と粒子のコントラスト

が一様な明コントラストになるよう、観察条件を決める。

使用画像を選択する。画像処理、解析に用いるソフトは

、画像の２値化、輪郭

図 2. 粒子径分布計測フロー図

ナノ粒子粒子径分布計測のプロトコルの検討にあたって、

の試料にはチタニア（

シリカナノ粒子は、形状が球状に近く、分散性が比較的良い。ただし、シリカの試料液を基板

に滴下して乾燥させようとするとシリカ粒子が基板に固定されないため分散媒の蒸発に伴い粒

子が凝集してしまう。一方、チタニアは、形状が複雑で、凝集性が強い扱いにくい試料である。
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濡れ性を良くするため、

分散液を基板に滴下し、乾燥させる。滴下後から乾燥過程

分散の良い状態を保ったまま

、粒子の種類に依らず

である。 

観察にあたり、

バックグランド（基板）と粒子のコントラスト

になるよう、観察条件を決める。 

使用画像を選択する。画像処理、解析に用いるソフトは

抽出を行い、粒子径

粒子径分布計測フロー図 

ナノ粒子粒子径分布計測のプロトコルの検討にあたって、WG

約 40nm）とシリカ（
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RRT

の技術に関する知識やノウハウの保有について各社のレベルがそろっていないことが判明した

ので、重要となるポイントを議論し、以下の様に整理した。

 

    

    

   これらのポイントについて、

粒子とチタニアナノ粒子について検討したので、以下４

凝集対策や

より具体的な検討内容を示した。（事例

ただし、

画機関の判断に委ねられ報告だけが求められた。平均粒子径の各機関間のバラつきは試料

調整、

にするために、凝集、分散状態の異なる

の比較を行うことにした。その結果を

4-1.

シリカナノ粒子で検討した結果を示す。

4-1

①水系分散液

観察試料を調製するために、ナノ粒子分散液を用いて作製した。ここでは、ナノ粒子

ら、

基板上に１次粒子が凝集なく、分散された

濃度の分散液を用いると、凝集が起こりやす

大する。

試料調製法を検討

RRT は２回実施した。第一回の

の技術に関する知識やノウハウの保有について各社のレベルがそろっていないことが判明した

ので、重要となるポイントを議論し、以下の様に整理した。

  (1)試料調製

①ナノ粒子分散液

②基板の親水化処理

③粒子の凝集抑制や基板への固着を強化するための添加剤の追加

④粒子の凝集抑制のために基板に分散液を滴下した後の処理

 (2)SEM 観察

①加速電圧

②画像のピクセルサイズ（倍率と画素数で決まる）

③視野選択（著しい局在がなく、ランダムに配置されている

 (3)画像解析

①ノイズや異物除去のためのフィルタ条件（面積、周囲長など）

②連結粒子、画像端粒子を計測に加えていないかを目視などで確認する

③凝集（重なり）が多い場合は、粒子が誤分割されたり、輪郭が内側になったりすること

により粒子径が小さく算出されることがある

④解析に求められる総粒子数（粒子径分布の精度向上）

これらのポイントについて、

粒子とチタニアナノ粒子について検討したので、以下４

凝集対策や SEM

より具体的な検討内容を示した。（事例

ただし、4-1、

画機関の判断に委ねられ報告だけが求められた。平均粒子径の各機関間のバラつきは試料

調整、SEM 観察条件

にするために、凝集、分散状態の異なる

の比較を行うことにした。その結果を

1. シリカナノ粒子

シリカナノ粒子で検討した結果を示す。

1-1. 試料調製

水系分散液の使用と濃度

観察試料を調製するために、ナノ粒子分散液を用いて作製した。ここでは、ナノ粒子

ら、分散液を作製する方法については述べない。水系分散液であり、市販のものを用い

基板上に１次粒子が凝集なく、分散された

濃度の分散液を用いると、凝集が起こりやす

大する。厳密に最適な濃度を検討したわけではないが、

試料調製法を検討
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は２回実施した。第一回の

の技術に関する知識やノウハウの保有について各社のレベルがそろっていないことが判明した

ので、重要となるポイントを議論し、以下の様に整理した。

試料調製 →ポイントは、凝集の低減と粒子数確保

①ナノ粒子分散液（水系）

基板の親水化処理

③粒子の凝集抑制や基板への固着を強化するための添加剤の追加

④粒子の凝集抑制のために基板に分散液を滴下した後の処理

観察 

①加速電圧 →画像のコントラストの最適化

②画像のピクセルサイズ（倍率と画素数で決まる）

③視野選択（著しい局在がなく、ランダムに配置されている

画像解析 

①ノイズや異物除去のためのフィルタ条件（面積、周囲長など）

②連結粒子、画像端粒子を計測に加えていないかを目視などで確認する

③凝集（重なり）が多い場合は、粒子が誤分割されたり、輪郭が内側になったりすること

により粒子径が小さく算出されることがある

④解析に求められる総粒子数（粒子径分布の精度向上）

これらのポイントについて、

粒子とチタニアナノ粒子について検討したので、以下４

SEM の加速電圧の選定などについては、他の試料の応用への参考となるように、

より具体的な検討内容を示した。（事例

、4-2 の RRT

画機関の判断に委ねられ報告だけが求められた。平均粒子径の各機関間のバラつきは試料

観察条件などの議論を通じて大きく改善された

にするために、凝集、分散状態の異なる

の比較を行うことにした。その結果を

シリカナノ粒子 

シリカナノ粒子で検討した結果を示す。

試料調製 

の使用と濃度

観察試料を調製するために、ナノ粒子分散液を用いて作製した。ここでは、ナノ粒子

分散液を作製する方法については述べない。水系分散液であり、市販のものを用い

基板上に１次粒子が凝集なく、分散された

濃度の分散液を用いると、凝集が起こりやす

厳密に最適な濃度を検討したわけではないが、

試料調製法を検討することに
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は２回実施した。第一回の RRT の結果を

の技術に関する知識やノウハウの保有について各社のレベルがそろっていないことが判明した

ので、重要となるポイントを議論し、以下の様に整理した。

→ポイントは、凝集の低減と粒子数確保

（水系）の濃度及び分散助剤

基板の親水化処理 

③粒子の凝集抑制や基板への固着を強化するための添加剤の追加

④粒子の凝集抑制のために基板に分散液を滴下した後の処理

→画像のコントラストの最適化

②画像のピクセルサイズ（倍率と画素数で決まる）

③視野選択（著しい局在がなく、ランダムに配置されている

①ノイズや異物除去のためのフィルタ条件（面積、周囲長など）

②連結粒子、画像端粒子を計測に加えていないかを目視などで確認する

③凝集（重なり）が多い場合は、粒子が誤分割されたり、輪郭が内側になったりすること

により粒子径が小さく算出されることがある

④解析に求められる総粒子数（粒子径分布の精度向上）

これらのポイントについて、RRT の実施においてどのような方法や条件が良いかをシリカナノ

粒子とチタニアナノ粒子について検討したので、以下４

の加速電圧の選定などについては、他の試料の応用への参考となるように、

より具体的な検討内容を示した。（事例 

RRT の実施においては画像解析のソフトウェアや解析方法の選択は参

画機関の判断に委ねられ報告だけが求められた。平均粒子径の各機関間のバラつきは試料

などの議論を通じて大きく改善された

にするために、凝集、分散状態の異なる

の比較を行うことにした。その結果を 4-3

シリカナノ粒子で検討した結果を示す。

の使用と濃度 

観察試料を調製するために、ナノ粒子分散液を用いて作製した。ここでは、ナノ粒子

分散液を作製する方法については述べない。水系分散液であり、市販のものを用い

基板上に１次粒子が凝集なく、分散された

濃度の分散液を用いると、凝集が起こりやす

厳密に最適な濃度を検討したわけではないが、

することにした。 
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の結果を WG

の技術に関する知識やノウハウの保有について各社のレベルがそろっていないことが判明した

ので、重要となるポイントを議論し、以下の様に整理した。

→ポイントは、凝集の低減と粒子数確保

の濃度及び分散助剤

③粒子の凝集抑制や基板への固着を強化するための添加剤の追加

④粒子の凝集抑制のために基板に分散液を滴下した後の処理

→画像のコントラストの最適化 

②画像のピクセルサイズ（倍率と画素数で決まる）

③視野選択（著しい局在がなく、ランダムに配置されている

①ノイズや異物除去のためのフィルタ条件（面積、周囲長など）

②連結粒子、画像端粒子を計測に加えていないかを目視などで確認する

③凝集（重なり）が多い場合は、粒子が誤分割されたり、輪郭が内側になったりすること

により粒子径が小さく算出されることがある 

④解析に求められる総粒子数（粒子径分布の精度向上）

の実施においてどのような方法や条件が良いかをシリカナノ

粒子とチタニアナノ粒子について検討したので、以下４

の加速電圧の選定などについては、他の試料の応用への参考となるように、

 1～事例 4 

の実施においては画像解析のソフトウェアや解析方法の選択は参

画機関の判断に委ねられ報告だけが求められた。平均粒子径の各機関間のバラつきは試料

などの議論を通じて大きく改善された

にするために、凝集、分散状態の異なる 3 種類の画像群を参画機関に配布して画像解析だけ

3 で述べる。

シリカナノ粒子で検討した結果を示す。 

観察試料を調製するために、ナノ粒子分散液を用いて作製した。ここでは、ナノ粒子

分散液を作製する方法については述べない。水系分散液であり、市販のものを用い

基板上に１次粒子が凝集なく、分散された試料を得るために、

濃度の分散液を用いると、凝集が起こりやすい。また、希薄すぎると、

厳密に最適な濃度を検討したわけではないが、
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WG 内で検討し

の技術に関する知識やノウハウの保有について各社のレベルがそろっていないことが判明した

ので、重要となるポイントを議論し、以下の様に整理した。 

→ポイントは、凝集の低減と粒子数確保                                  

の濃度及び分散助剤 

③粒子の凝集抑制や基板への固着を強化するための添加剤の追加

④粒子の凝集抑制のために基板に分散液を滴下した後の処理

②画像のピクセルサイズ（倍率と画素数で決まる） →粒子径計測の精度確保

③視野選択（著しい局在がなく、ランダムに配置されている

①ノイズや異物除去のためのフィルタ条件（面積、周囲長など）

②連結粒子、画像端粒子を計測に加えていないかを目視などで確認する

③凝集（重なり）が多い場合は、粒子が誤分割されたり、輪郭が内側になったりすること

 

④解析に求められる総粒子数（粒子径分布の精度向上） 

の実施においてどのような方法や条件が良いかをシリカナノ

粒子とチタニアナノ粒子について検討したので、以下４-1 節と 4-

の加速電圧の選定などについては、他の試料の応用への参考となるように、

4 参照） 

の実施においては画像解析のソフトウェアや解析方法の選択は参

画機関の判断に委ねられ報告だけが求められた。平均粒子径の各機関間のバラつきは試料

などの議論を通じて大きく改善された。そこで、

種類の画像群を参画機関に配布して画像解析だけ

で述べる。 

観察試料を調製するために、ナノ粒子分散液を用いて作製した。ここでは、ナノ粒子

分散液を作製する方法については述べない。水系分散液であり、市販のものを用い

試料を得るために、分散液の

い。また、希薄すぎると、

厳密に最適な濃度を検討したわけではないが、今回は濃度
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内で検討した結果、参加機関の間で計測

の技術に関する知識やノウハウの保有について各社のレベルがそろっていないことが判明した

                                 

③粒子の凝集抑制や基板への固着を強化するための添加剤の追加 

④粒子の凝集抑制のために基板に分散液を滴下した後の処理 

→粒子径計測の精度確保

③視野選択（著しい局在がなく、ランダムに配置されている領域を選択）

①ノイズや異物除去のためのフィルタ条件（面積、周囲長など） 

②連結粒子、画像端粒子を計測に加えていないかを目視などで確認する

③凝集（重なり）が多い場合は、粒子が誤分割されたり、輪郭が内側になったりすること

 

の実施においてどのような方法や条件が良いかをシリカナノ

-2 節で述べる。試料調整での

の加速電圧の選定などについては、他の試料の応用への参考となるように、

の実施においては画像解析のソフトウェアや解析方法の選択は参

画機関の判断に委ねられ報告だけが求められた。平均粒子径の各機関間のバラつきは試料

。そこで、凝集に対する課題を明確

種類の画像群を参画機関に配布して画像解析だけ

観察試料を調製するために、ナノ粒子分散液を用いて作製した。ここでは、ナノ粒子

分散液を作製する方法については述べない。水系分散液であり、市販のものを用い

分散液の濃度が重要である。

い。また、希薄すぎると、撮影にかかる時間が増

濃度を 0.1wt%
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た結果、参加機関の間で計測

の技術に関する知識やノウハウの保有について各社のレベルがそろっていないことが判明した

                                 

 

→粒子径計測の精度確保 

を選択） 

②連結粒子、画像端粒子を計測に加えていないかを目視などで確認する 

③凝集（重なり）が多い場合は、粒子が誤分割されたり、輪郭が内側になったりすること

の実施においてどのような方法や条件が良いかをシリカナノ

節で述べる。試料調整での

の加速電圧の選定などについては、他の試料の応用への参考となるように、

の実施においては画像解析のソフトウェアや解析方法の選択は参

画機関の判断に委ねられ報告だけが求められた。平均粒子径の各機関間のバラつきは試料

凝集に対する課題を明確

種類の画像群を参画機関に配布して画像解析だけ

観察試料を調製するために、ナノ粒子分散液を用いて作製した。ここでは、ナノ粒子粉体

分散液を作製する方法については述べない。水系分散液であり、市販のものを用いている

が重要である。

撮影にかかる時間が増

0.1wt%とし、これ以降の

 

 4 
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た結果、参加機関の間で計測

の技術に関する知識やノウハウの保有について各社のレベルがそろっていないことが判明した

                                  

③凝集（重なり）が多い場合は、粒子が誤分割されたり、輪郭が内側になったりすること

の実施においてどのような方法や条件が良いかをシリカナノ 

節で述べる。試料調整での 

の加速電圧の選定などについては、他の試料の応用への参考となるように、 

の実施においては画像解析のソフトウェアや解析方法の選択は参

画機関の判断に委ねられ報告だけが求められた。平均粒子径の各機関間のバラつきは試料

凝集に対する課題を明確

種類の画像群を参画機関に配布して画像解析だけ

粉体か

ている。

が重要である。高

撮影にかかる時間が増

以降の



 

 

②分散液に添加する添加剤

シリカ

HEC

グリッドを用いた場合に見られた効果を示す。

事例

[試料処理法

試料

基板

前処理

試料固定：

[SEM

   (1)

 

 

 

 

 

 

 

 

 

分散液に添加する添加剤

シリカナノ粒子

HEC（ヒドロキシエチルセルロース）を

グリッドを用いた場合に見られた効果を示す。

事例 1:  シリコン基板

試料処理法] 

試料    ： 微粒子分散水溶液

基板    ： Si

前処理  ： 基板表面を

DC

試料固定： ガラス毛細管ピペットで約

SEM 像] 

(1) HEC 添加無しで試料処理した場合のシリカ（

 

 

 

 

 

 

 

 

 

(b）ナノ粒子の比較的密度の低い部分（×

図 3. HEC
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分散液に添加する添加剤

ナノ粒子は、分散状態が良い

（ヒドロキシエチルセルロース）を

グリッドを用いた場合に見られた効果を示す。

シリコン基板を用いた場合

微粒子分散水溶液

SiO2 は HEC

Si 基板 

基板表面をプラズマエッチング装置（日本電子製

DC プラズマ処理

ガラス毛細管ピペットで約

添加無しで試料処理した場合のシリカ（

（a）ナノ粒子の密度の高い部分（×

）ナノ粒子の比較的密度の低い部分（×

3. HEC 添加無しで試料処理した場合のシリカ（
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分散液に添加する添加剤 

分散状態が良い粒子

（ヒドロキシエチルセルロース）を候補として選び、

グリッドを用いた場合に見られた効果を示す。

を用いた場合の HEC

微粒子分散水溶液 シリカ（

HEC（和光純薬工業製

プラズマエッチング装置（日本電子製

プラズマ処理により親水化

ガラス毛細管ピペットで約

添加無しで試料処理した場合のシリカ（

）ナノ粒子の密度の高い部分（×

）ナノ粒子の比較的密度の低い部分（×

添加無しで試料処理した場合のシリカ（
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粒子であるが、滴下後、基板上で凝集を抑制するために、

候補として選び、

グリッドを用いた場合に見られた効果を示す。（事例

HEC 添加効果 

シリカ（SiO2, 日産化学製

（和光純薬工業製 和光一級）

プラズマエッチング装置（日本電子製

により親水化 

ガラス毛細管ピペットで約 1μL 滴下。滴下

添加無しで試料処理した場合のシリカ（SiO

）ナノ粒子の密度の高い部分（×

）ナノ粒子の比較的密度の低い部分（×1k）       

添加無しで試料処理した場合のシリカ（

 

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

であるが、滴下後、基板上で凝集を抑制するために、

候補として選び、効果を調べた。以下に、シリコンと

（事例 1 及び事例 2

 

日産化学製） 

和光一級）1%水溶液を、

プラズマエッチング装置（日本電子製 

滴下。滴下 10 秒後に濾紙で分散液を除去

SiO2）の SEM 観察例

）ナノ粒子の密度の高い部分（×10k） 

 

 

          (C) 

添加無しで試料処理した場合のシリカ（SiO2）
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であるが、滴下後、基板上で凝集を抑制するために、

を調べた。以下に、シリコンと

2 参照）   

水溶液を、0.4%添加

HDT-400） を使用し、

秒後に濾紙で分散液を除去

観察例 

 

 (b)の拡大（×

）/Si 基板の SEM
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であるが、滴下後、基板上で凝集を抑制するために、

を調べた。以下に、シリコンと TEM

0.4%添加  

を使用し、2 分間

秒後に濾紙で分散液を除去

の拡大（×10k） 

SEM 像 
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であるが、滴下後、基板上で凝集を抑制するために、

TEM

分間

秒後に濾紙で分散液を除去 



 

 

 

 

 

 

 

 

 

 

 

 

 

事例

で凝集する

  存在する確率は高いものの、図

  高い確率で、

 TEM

 

事例

  

HEC

添加した。フォルムバール支持膜つきの

支持膜側から

は

燥させ、

図

シリカナノ粒子が明コントラストで観察され、粒子数は

みられた。

30 µL/mL

されるが

  以上より、

示された。また、その添加量により、

かった。

することで適した密度の粒子が得られる。

本手法は、凝集を抑制しつつ、シリカナノ粒子を

凝集抑制メカニズムの詳細は今後の議論であるが、簡便な操

(2) HEC 添加有りで試料処理した場合のシリカ（

図 4. HEC

事例1から、

で凝集する部分が見られる一方、

存在する確率は高いものの、図

高い確率で、1

TEM グリッドを基板に用いた場合の

事例 2 : TEM グリッド

 ここでは、HEC

HEC の 1%水溶性を調整し、

添加した。フォルムバール支持膜つきの

支持膜側から

は TEM グリッドから溢れ、敷かれた濾紙により吸い取られる。

燥させ、SEM 観察を行った。

図 5 に HEC

シリカナノ粒子が明コントラストで観察され、粒子数は

みられた。10 µL/mL

30 µL/mL の添加ではグリッド外縁部から開口部中央へ向かう明コントラストの模様が観察

されるが、このような

以上より、HEC

示された。また、その添加量により、

かった。0.1wt%のシリカナノ粒子の粒径計測を行うためには

することで適した密度の粒子が得られる。

本手法は、凝集を抑制しつつ、シリカナノ粒子を

凝集抑制メカニズムの詳細は今後の議論であるが、簡便な操
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添加有りで試料処理した場合のシリカ（

4. HEC 添加有りで試料処理した場合のシリカ（

から、HEC添加ない場合

部分が見られる一方、

存在する確率は高いものの、図

1 次粒子が分離して存在していた。

グリッドを基板に用いた場合の

グリッドを基板に用いた場合の

HEC を添加することによる凝集抑制効果、またその

水溶性を調整し、

添加した。フォルムバール支持膜つきの

支持膜側から HEC を添加したシリカ分散液をそれぞれ

グリッドから溢れ、敷かれた濾紙により吸い取られる。

観察を行った。

HEC 添加試料の

シリカナノ粒子が明コントラストで観察され、粒子数は

10 µL/mL の HEC

の添加ではグリッド外縁部から開口部中央へ向かう明コントラストの模様が観察

、このような箇所では粒子の積層が見られた。

HEC の添加により、

示された。また、その添加量により、

のシリカナノ粒子の粒径計測を行うためには

することで適した密度の粒子が得られる。

本手法は、凝集を抑制しつつ、シリカナノ粒子を

凝集抑制メカニズムの詳細は今後の議論であるが、簡便な操
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添加有りで試料処理した場合のシリカ（

添加有りで試料処理した場合のシリカ（

添加ない場合（図3）

部分が見られる一方、HEC 添加をした場合

存在する確率は高いものの、図 3(a),(b)

次粒子が分離して存在していた。

グリッドを基板に用いた場合の HEC

を基板に用いた場合の

を添加することによる凝集抑制効果、またその

水溶性を調整し、0.1wt%のシリカナノ粒子分散液

添加した。フォルムバール支持膜つきの

を添加したシリカ分散液をそれぞれ

グリッドから溢れ、敷かれた濾紙により吸い取られる。

観察を行った。 

添加試料の SEM 像（低倍率像：左、高倍率像：右）を示す。

シリカナノ粒子が明コントラストで観察され、粒子数は

HEC 添加でグリッドほぼ全体がシリ

の添加ではグリッド外縁部から開口部中央へ向かう明コントラストの模様が観察

箇所では粒子の積層が見られた。

の添加により、TEM グリッド上にシリカナノ粒子を配置する効果があることが

示された。また、その添加量により、TEM

のシリカナノ粒子の粒径計測を行うためには

することで適した密度の粒子が得られる。

本手法は、凝集を抑制しつつ、シリカナノ粒子を

凝集抑制メカニズムの詳細は今後の議論であるが、簡便な操
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添加有りで試料処理した場合のシリカ（SiO

添加有りで試料処理した場合のシリカ（

）は、ナノ粒子が高密度で凝集

添加をした場合

3(a),(b)のような状態はほとんど存在せず、ほぼ全域にわた

次粒子が分離して存在していた。（図

HEC 添加効果について、事例

を基板に用いた場合の HEC 添加効果

を添加することによる凝集抑制効果、またその

のシリカナノ粒子分散液

添加した。フォルムバール支持膜つきの TEM グリッドの

を添加したシリカ分散液をそれぞれ

グリッドから溢れ、敷かれた濾紙により吸い取られる。

像（低倍率像：左、高倍率像：右）を示す。

シリカナノ粒子が明コントラストで観察され、粒子数は

添加でグリッドほぼ全体がシリ

の添加ではグリッド外縁部から開口部中央へ向かう明コントラストの模様が観察

箇所では粒子の積層が見られた。

グリッド上にシリカナノ粒子を配置する効果があることが

TEM グリッド上の粒子密度をコントロールできることがわ

のシリカナノ粒子の粒径計測を行うためには

することで適した密度の粒子が得られる。 

本手法は、凝集を抑制しつつ、シリカナノ粒子を TEM

凝集抑制メカニズムの詳細は今後の議論であるが、簡便な操
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SiO2）の SEM

添加有りで試料処理した場合のシリカ（SiO2）/Si 基板の

は、ナノ粒子が高密度で凝集

添加をした場合は、粒子密度が高い部分は、集合体の

のような状態はほとんど存在せず、ほぼ全域にわた

（図 4） 

添加効果について、事例

添加効果 

を添加することによる凝集抑制効果、またその

のシリカナノ粒子分散液 1mL

グリッドの支持膜を上に向け濾紙の上に置き、

を添加したシリカ分散液をそれぞれ 30 µL 滴下した。この時余剰な分散液

グリッドから溢れ、敷かれた濾紙により吸い取られる。TEM

像（低倍率像：左、高倍率像：右）を示す。

シリカナノ粒子が明コントラストで観察され、粒子数は HEC の添加量とともに増加する傾向が

添加でグリッドほぼ全体がシリカナノ粒子に覆われていた。

の添加ではグリッド外縁部から開口部中央へ向かう明コントラストの模様が観察

箇所では粒子の積層が見られた。 

グリッド上にシリカナノ粒子を配置する効果があることが

グリッド上の粒子密度をコントロールできることがわ

のシリカナノ粒子の粒径計測を行うためには 4.5µL/mL

TEM グリッド上に配置できる方法である。

凝集抑制メカニズムの詳細は今後の議論であるが、簡便な操作で試料調製を実現できること
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SEM 観察例 

基板の SEM

は、ナノ粒子が高密度で凝集する部分、比較的低密度

粒子密度が高い部分は、集合体の

のような状態はほとんど存在せず、ほぼ全域にわた

添加効果について、事例 2 に示す。

を添加することによる凝集抑制効果、またその HEC 添加量依存性を検討した。

1mL に対し、2, 4.5, 10, 30 µL

支持膜を上に向け濾紙の上に置き、

滴下した。この時余剰な分散液

TEM グリッドを

像（低倍率像：左、高倍率像：右）を示す。TEM

の添加量とともに増加する傾向が

ナノ粒子に覆われていた。

の添加ではグリッド外縁部から開口部中央へ向かう明コントラストの模様が観察

グリッド上にシリカナノ粒子を配置する効果があることが

グリッド上の粒子密度をコントロールできることがわ

4.5µL/mL 程度の

グリッド上に配置できる方法である。

作で試料調製を実現できること
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SEM 像（×30k） 

する部分、比較的低密度

粒子密度が高い部分は、集合体の

のような状態はほとんど存在せず、ほぼ全域にわた

に示す。 

添加量依存性を検討した。

2, 4.5, 10, 30 µL

支持膜を上に向け濾紙の上に置き、

滴下した。この時余剰な分散液

グリッドを 30 分以上自然乾

TEM グリッド上の

の添加量とともに増加する傾向が

ナノ粒子に覆われていた。 

の添加ではグリッド外縁部から開口部中央へ向かう明コントラストの模様が観察

グリッド上にシリカナノ粒子を配置する効果があることが

グリッド上の粒子密度をコントロールできることがわ

程度の HEC 添加を

グリッド上に配置できる方法である。

作で試料調製を実現できること
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する部分、比較的低密度

粒子密度が高い部分は、集合体の 

のような状態はほとんど存在せず、ほぼ全域にわたり 

添加量依存性を検討した。

2, 4.5, 10, 30 µL ずつ

支持膜を上に向け濾紙の上に置き、

滴下した。この時余剰な分散液

分以上自然乾

グリッド上の 

の添加量とともに増加する傾向が 

  

の添加ではグリッド外縁部から開口部中央へ向かう明コントラストの模様が観察 

グリッド上にシリカナノ粒子を配置する効果があることが

グリッド上の粒子密度をコントロールできることがわ 

添加を 

グリッド上に配置できる方法である。 

作で試料調製を実現できること 



 

 

から、実用的な手法であるといえる。

   

から、実用的な手法であるといえる。

HEC
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から、実用的な手法であるといえる。

図 5.HEC

HEC 水溶液添加量：
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から、実用的な手法であるといえる。 

HEC 添加法により調製したシリカの粒子試料の

水溶液添加量：(a) 2 µL/mL, (b) 4.5 µL/mL, (c) 10 µL/mL, (d) 30 µL/mL
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添加法により調製したシリカの粒子試料の

(a) 2 µL/mL, (b) 4.5 µL/mL, (c) 10 µL/mL, (d) 30 µL/mL
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添加法により調製したシリカの粒子試料の

(a) 2 µL/mL, (b) 4.5 µL/mL, (c) 10 µL/mL, (d) 30 µL/mL
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添加法により調製したシリカの粒子試料の SEM

(a) 2 µL/mL, (b) 4.5 µL/mL, (c) 10 µL/mL, (d) 30 µL/mL
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SEM 像 

(a) 2 µL/mL, (b) 4.5 µL/mL, (c) 10 µL/mL, (d) 30 µL/mL
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(a) 2 µL/mL, (b) 4.5 µL/mL, (c) 10 µL/mL, (d) 30 µL/mL 



 

 

HEC

可能性があり、今後の発展が期待される。

水溶液は、増粘

  おり、上記事例で述べた効果を裏づけていると考えられる。

 ③基板について

SEM

メッシュ上にカーボン支持膜、コロジオン支持膜が付いている

特に指定はしていないが、一般的によく用いられているシリコンウェハーまたは

使用された。

④親水化処理

分散液を基板に滴下後、基板表面にナノ粒子を凝集なく、均一に分散させるために基板の親

水化処理は必要である。水系分散液を

制する効果がある。

親水化処理法は、プラズマ処理、

は、エタノールによる洗浄や、シリコン基板に限ってはガラス容器中で適度に加温した

溶液（例えば濃硫酸

浸す等の方法がある。

 ⑤滴下後処理、乾燥法について

  分散液を基板に滴下後、試料を乾燥する方法

がある。

   

4-1-

①SEM

  SEM

 PS

依存性について事例

件を決めていただきたい。

  シリカの

 

②画像のピクセルサイズ

   

1.5nm/px

 

 

 

 

  

HEC は、シリカ粒子以外の粒子や

可能性があり、今後の発展が期待される。

溶液は、増粘

おり、上記事例で述べた効果を裏づけていると考えられる。

③基板について 

SEM 観察試料に用いる基板には、シリコンウェハー、

メッシュ上にカーボン支持膜、コロジオン支持膜が付いている

特に指定はしていないが、一般的によく用いられているシリコンウェハーまたは

使用された。 

④親水化処理 

分散液を基板に滴下後、基板表面にナノ粒子を凝集なく、均一に分散させるために基板の親

水化処理は必要である。水系分散液を

制する効果がある。

親水化処理法は、プラズマ処理、

は、エタノールによる洗浄や、シリコン基板に限ってはガラス容器中で適度に加温した

溶液（例えば濃硫酸

浸す等の方法がある。

⑤滴下後処理、乾燥法について

分散液を基板に滴下後、試料を乾燥する方法

がある。主に、室温にて、

-2. SEM 観察

SEM 観察条件

SEM の加速電圧は、

PS（ポリスチレン）ナノ粒子（平均粒径

依存性について事例

件を決めていただきたい。

シリカの RRT

②画像のピクセルサイズ

 RRT では 100nm

1.5nm/px より小さくすることとした。
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シリカ粒子以外の粒子や

可能性があり、今後の発展が期待される。

溶液は、増粘、懸濁、分散

おり、上記事例で述べた効果を裏づけていると考えられる。

 

観察試料に用いる基板には、シリコンウェハー、

メッシュ上にカーボン支持膜、コロジオン支持膜が付いている

特に指定はしていないが、一般的によく用いられているシリコンウェハーまたは

 

分散液を基板に滴下後、基板表面にナノ粒子を凝集なく、均一に分散させるために基板の親

水化処理は必要である。水系分散液を

制する効果がある。 

親水化処理法は、プラズマ処理、

は、エタノールによる洗浄や、シリコン基板に限ってはガラス容器中で適度に加温した

溶液（例えば濃硫酸 ： 30%

浸す等の方法がある。 

⑤滴下後処理、乾燥法について

分散液を基板に滴下後、試料を乾燥する方法

室温にて、30 分以上乾燥させている

観察 

観察条件 

の加速電圧は、一つの粒子の

（ポリスチレン）ナノ粒子（平均粒径

依存性について事例（事例

件を決めていただきたい。 

RRT での加速電圧その他の観察条件の事例を

②画像のピクセルサイズ 

100nm 以下の粒子径の測定精度を確保するために、画像のピクセルサイズは、

より小さくすることとした。
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シリカ粒子以外の粒子や TEM

可能性があり、今後の発展が期待される。

分散、保護コロイドなどの優れた機能を有し

おり、上記事例で述べた効果を裏づけていると考えられる。

観察試料に用いる基板には、シリコンウェハー、

メッシュ上にカーボン支持膜、コロジオン支持膜が付いている

特に指定はしていないが、一般的によく用いられているシリコンウェハーまたは

分散液を基板に滴下後、基板表面にナノ粒子を凝集なく、均一に分散させるために基板の親

水化処理は必要である。水系分散液を使用する場合、濡れ性を良くすることにより、凝集を抑

親水化処理法は、プラズマ処理、UV オゾン処理がある。プラズマ処理装置などがない場合

は、エタノールによる洗浄や、シリコン基板に限ってはガラス容器中で適度に加温した

30%過酸化水素水＝

⑤滴下後処理、乾燥法について 

分散液を基板に滴下後、試料を乾燥する方法

分以上乾燥させている

一つの粒子の表面上の

（ポリスチレン）ナノ粒子（平均粒径 50 nm

事例 3 参照）を示す。

 

加速電圧その他の観察条件の事例を

以下の粒子径の測定精度を確保するために、画像のピクセルサイズは、

より小さくすることとした。 
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TEM グリッド、シリコン

可能性があり、今後の発展が期待される。また、HEC

保護コロイドなどの優れた機能を有し

おり、上記事例で述べた効果を裏づけていると考えられる。

観察試料に用いる基板には、シリコンウェハー、

メッシュ上にカーボン支持膜、コロジオン支持膜が付いている

特に指定はしていないが、一般的によく用いられているシリコンウェハーまたは

分散液を基板に滴下後、基板表面にナノ粒子を凝集なく、均一に分散させるために基板の親

使用する場合、濡れ性を良くすることにより、凝集を抑

オゾン処理がある。プラズマ処理装置などがない場合

は、エタノールによる洗浄や、シリコン基板に限ってはガラス容器中で適度に加温した

過酸化水素水＝3：1 (ただし調製や廃棄には十分に注意のこと）

分散液を基板に滴下後、試料を乾燥する方法は、自然乾燥（室温乾燥）、真空乾燥、加熱乾燥

分以上乾燥させている場合が多い。

表面上のコントラストに影響を与える。ここでは、参考に

50 nm）を用いた場合の粒子内コントラストの加速電圧

示す。加速電圧他、観察条件は、事例を参考に最適な条

加速電圧その他の観察条件の事例を

以下の粒子径の測定精度を確保するために、画像のピクセルサイズは、
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、シリコン以外の基板の場合にも適応できる

HEC は、水溶性

保護コロイドなどの優れた機能を有し

おり、上記事例で述べた効果を裏づけていると考えられる。 

観察試料に用いる基板には、シリコンウェハー、TEM グリッド（銅あるいはモリブデン製

メッシュ上にカーボン支持膜、コロジオン支持膜が付いている）、アルミ箔などがある

特に指定はしていないが、一般的によく用いられているシリコンウェハーまたは

分散液を基板に滴下後、基板表面にナノ粒子を凝集なく、均一に分散させるために基板の親

使用する場合、濡れ性を良くすることにより、凝集を抑

オゾン処理がある。プラズマ処理装置などがない場合

は、エタノールによる洗浄や、シリコン基板に限ってはガラス容器中で適度に加温した

ただし調製や廃棄には十分に注意のこと）

、自然乾燥（室温乾燥）、真空乾燥、加熱乾燥

場合が多い。 

ントラストに影響を与える。ここでは、参考に

）を用いた場合の粒子内コントラストの加速電圧

加速電圧他、観察条件は、事例を参考に最適な条

加速電圧その他の観察条件の事例を付録の表

以下の粒子径の測定精度を確保するために、画像のピクセルサイズは、
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以外の基板の場合にも適応できる

水溶性の高分子化合物で

保護コロイドなどの優れた機能を有していることが知られて

グリッド（銅あるいはモリブデン製

）、アルミ箔などがある

特に指定はしていないが、一般的によく用いられているシリコンウェハーまたは

分散液を基板に滴下後、基板表面にナノ粒子を凝集なく、均一に分散させるために基板の親

使用する場合、濡れ性を良くすることにより、凝集を抑

オゾン処理がある。プラズマ処理装置などがない場合

は、エタノールによる洗浄や、シリコン基板に限ってはガラス容器中で適度に加温した

ただし調製や廃棄には十分に注意のこと）

、自然乾燥（室温乾燥）、真空乾燥、加熱乾燥

 

ントラストに影響を与える。ここでは、参考に

）を用いた場合の粒子内コントラストの加速電圧

加速電圧他、観察条件は、事例を参考に最適な条

付録の表 A.2 に載せた。

以下の粒子径の測定精度を確保するために、画像のピクセルサイズは、
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以外の基板の場合にも適応できる

高分子化合物であり、

ていることが知られて

グリッド（銅あるいはモリブデン製

）、アルミ箔などがある。RRT

特に指定はしていないが、一般的によく用いられているシリコンウェハーまたは TEM グリッドが

分散液を基板に滴下後、基板表面にナノ粒子を凝集なく、均一に分散させるために基板の親

使用する場合、濡れ性を良くすることにより、凝集を抑

オゾン処理がある。プラズマ処理装置などがない場合

は、エタノールによる洗浄や、シリコン基板に限ってはガラス容器中で適度に加温したピラニア

ただし調製や廃棄には十分に注意のこと）

、自然乾燥（室温乾燥）、真空乾燥、加熱乾燥

ントラストに影響を与える。ここでは、参考に

）を用いた場合の粒子内コントラストの加速電圧

加速電圧他、観察条件は、事例を参考に最適な条

載せた。 

以下の粒子径の測定精度を確保するために、画像のピクセルサイズは、
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以外の基板の場合にも適応できる

あり、その

ていることが知られて 

グリッド（銅あるいはモリブデン製 

RRT では

グリッドが

分散液を基板に滴下後、基板表面にナノ粒子を凝集なく、均一に分散させるために基板の親

使用する場合、濡れ性を良くすることにより、凝集を抑

オゾン処理がある。プラズマ処理装置などがない場合

ピラニア

ただし調製や廃棄には十分に注意のこと）に

、自然乾燥（室温乾燥）、真空乾燥、加熱乾燥

ントラストに影響を与える。ここでは、参考に 

）を用いた場合の粒子内コントラストの加速電圧

加速電圧他、観察条件は、事例を参考に最適な条

以下の粒子径の測定精度を確保するために、画像のピクセルサイズは、



 

 

 

事例

 

ポリカチオンレイヤーを有する鏡面研摩

した。

エネルギーを変化させながら像観察を行った。

チャンバー内壁面に取り付けられた

0.5

確保するため、試料に負電圧

試料直上の鏡筒内に設置された

一次電子エネルギー

子として現れる

エッジ効果の大きな寄与によって

5 keV 

では粒子全体が均一な明コントラストとして現れる。一次電子エネルギー

が得られるが、電子線の収束が難しくなるため、今回用いた

低下する。

て観察されるが、高エネルギー条件とは反対に、

な暗コントラストである。また、スキャン方向に平行に線を引いたようなアーティファクトが観察さ

れ、これの条件では、試料帯電が発生していることが示唆される。

以上から、粒径

が得られる場合は

よる縁取りの形成を抑制し、一様なコ

うなコントラストの粒子像はソフトウェアにより容易に自動粒子解析を行うことが可能であろう。

このような条件で十分な像分解能が得られない

いるが、

 検討するのが望ましい。

   

   

   

   

   

   

 

 

 

事例 3： PS（ポリスチレン）ナノ粒子（平均粒径

加速電圧依存性

ポリカチオンレイヤーを有する鏡面研摩

した。 SEM 装置は電界放出型電子銃を搭載したアウトレンズ型の

エネルギーを変化させながら像観察を行った。

チャンバー内壁面に取り付けられた

0.5keV から 0.1keV

確保するため、試料に負電圧

試料直上の鏡筒内に設置された

一次電子エネルギー

子として現れる

エッジ効果の大きな寄与によって

5 keV にかけて一次電子エネルギーの低下とともに、縁取り内部のコントラストが増加し、

では粒子全体が均一な明コントラストとして現れる。一次電子エネルギー

が得られるが、電子線の収束が難しくなるため、今回用いた

低下する。0.5 keV

て観察されるが、高エネルギー条件とは反対に、

な暗コントラストである。また、スキャン方向に平行に線を引いたようなアーティファクトが観察さ

れ、これの条件では、試料帯電が発生していることが示唆される。

以上から、粒径

が得られる場合は

よる縁取りの形成を抑制し、一様なコ

うなコントラストの粒子像はソフトウェアにより容易に自動粒子解析を行うことが可能であろう。

このような条件で十分な像分解能が得られない

いるが、PS 粒子のコントラストが十分得られる動作距離

検討するのが望ましい。
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（ポリスチレン）ナノ粒子（平均粒径

加速電圧依存性 

ポリカチオンレイヤーを有する鏡面研摩

装置は電界放出型電子銃を搭載したアウトレンズ型の

エネルギーを変化させながら像観察を行った。

チャンバー内壁面に取り付けられた

0.1keV までの一次電子エネルギー条件では粒子像観察のために必要な分解能を

確保するため、試料に負電圧

試料直上の鏡筒内に設置された

一次電子エネルギー15keV 

子として現れる。粒子のエッジの内側の明るさは

エッジ効果の大きな寄与によって

にかけて一次電子エネルギーの低下とともに、縁取り内部のコントラストが増加し、

では粒子全体が均一な明コントラストとして現れる。一次電子エネルギー

が得られるが、電子線の収束が難しくなるため、今回用いた

0.5 keV 以下のリターディング条件では、

て観察されるが、高エネルギー条件とは反対に、

な暗コントラストである。また、スキャン方向に平行に線を引いたようなアーティファクトが観察さ

れ、これの条件では、試料帯電が発生していることが示唆される。

以上から、粒径 50nm 程度の

が得られる場合は 3kV の加速電圧条件が適しているといえる。この条件下では、エッジ効果に

よる縁取りの形成を抑制し、一様なコ

うなコントラストの粒子像はソフトウェアにより容易に自動粒子解析を行うことが可能であろう。

このような条件で十分な像分解能が得られない

粒子のコントラストが十分得られる動作距離

検討するのが望ましい。（次頁に続く）
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（ポリスチレン）ナノ粒子（平均粒径

ポリカチオンレイヤーを有する鏡面研摩

装置は電界放出型電子銃を搭載したアウトレンズ型の

エネルギーを変化させながら像観察を行った。

チャンバー内壁面に取り付けられた Everhart

までの一次電子エネルギー条件では粒子像観察のために必要な分解能を

確保するため、試料に負電圧(-2kV)を印加するリターディング条件で観察を行い、二次電子は

試料直上の鏡筒内に設置された TTL 検出器で検出した

15keV での二次電子像で

粒子のエッジの内側の明るさは

エッジ効果の大きな寄与によって PS 粒子の情報がもたらされていることがわかる。

にかけて一次電子エネルギーの低下とともに、縁取り内部のコントラストが増加し、

では粒子全体が均一な明コントラストとして現れる。一次電子エネルギー

が得られるが、電子線の収束が難しくなるため、今回用いた

以下のリターディング条件では、

て観察されるが、高エネルギー条件とは反対に、

な暗コントラストである。また、スキャン方向に平行に線を引いたようなアーティファクトが観察さ

れ、これの条件では、試料帯電が発生していることが示唆される。

程度の PS ナノ粒子の計測を行う際には、粒径計測に十分な像分解能

の加速電圧条件が適しているといえる。この条件下では、エッジ効果に

よる縁取りの形成を抑制し、一様なコントラストで

うなコントラストの粒子像はソフトウェアにより容易に自動粒子解析を行うことが可能であろう。

このような条件で十分な像分解能が得られない

粒子のコントラストが十分得られる動作距離

（次頁に続く） 

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

（ポリスチレン）ナノ粒子（平均粒径 50 nm

ポリカチオンレイヤーを有する鏡面研摩 Si 基板上に

装置は電界放出型電子銃を搭載したアウトレンズ型の

エネルギーを変化させながら像観察を行った。15keV

Everhart-Thornley

までの一次電子エネルギー条件では粒子像観察のために必要な分解能を

を印加するリターディング条件で観察を行い、二次電子は

検出器で検出した

での二次電子像で PS

粒子のエッジの内側の明るさは Si 基板のそれとほぼ同レベルであることから、

粒子の情報がもたらされていることがわかる。

にかけて一次電子エネルギーの低下とともに、縁取り内部のコントラストが増加し、

では粒子全体が均一な明コントラストとして現れる。一次電子エネルギー

が得られるが、電子線の収束が難しくなるため、今回用いた

以下のリターディング条件では、PS

て観察されるが、高エネルギー条件とは反対に、PS

な暗コントラストである。また、スキャン方向に平行に線を引いたようなアーティファクトが観察さ

れ、これの条件では、試料帯電が発生していることが示唆される。

ナノ粒子の計測を行う際には、粒径計測に十分な像分解能

の加速電圧条件が適しているといえる。この条件下では、エッジ効果に

ントラストで PS

うなコントラストの粒子像はソフトウェアにより容易に自動粒子解析を行うことが可能であろう。

このような条件で十分な像分解能が得られない SEM

粒子のコントラストが十分得られる動作距離
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50 nm）を用いた場合の粒子内コントラストの

基板上に PS 粒子を配置し、

装置は電界放出型電子銃を搭載したアウトレンズ型の

keV から 1keV での条件では二次電子は試料

Thornley 型検出器で検出した

までの一次電子エネルギー条件では粒子像観察のために必要な分解能を

を印加するリターディング条件で観察を行い、二次電子は

検出器で検出した[図 6.(m)

PS 粒子は明コントラストの縁取りをもった粒

基板のそれとほぼ同レベルであることから、

粒子の情報がもたらされていることがわかる。

にかけて一次電子エネルギーの低下とともに、縁取り内部のコントラストが増加し、

では粒子全体が均一な明コントラストとして現れる。一次電子エネルギー

が得られるが、電子線の収束が難しくなるため、今回用いた SEM

PS ナノ粒子は再び縁取りを伴った粒子とし

PS ナノ粒子中心部は

な暗コントラストである。また、スキャン方向に平行に線を引いたようなアーティファクトが観察さ

れ、これの条件では、試料帯電が発生していることが示唆される。

ナノ粒子の計測を行う際には、粒径計測に十分な像分解能

の加速電圧条件が適しているといえる。この条件下では、エッジ効果に

PS 粒子を観察することが可能である。このよ

うなコントラストの粒子像はソフトウェアにより容易に自動粒子解析を行うことが可能であろう。

SEM 装置では、10

粒子のコントラストが十分得られる動作距離(W.D.)、スキャンスピードや照射電流を
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）を用いた場合の粒子内コントラストの

粒子を配置し、SEM

装置は電界放出型電子銃を搭載したアウトレンズ型の SEM 装置を用い、一次電子

での条件では二次電子は試料

型検出器で検出した[

までの一次電子エネルギー条件では粒子像観察のために必要な分解能を

を印加するリターディング条件で観察を行い、二次電子は

(m)-(p)]。 

粒子は明コントラストの縁取りをもった粒

基板のそれとほぼ同レベルであることから、

粒子の情報がもたらされていることがわかる。

にかけて一次電子エネルギーの低下とともに、縁取り内部のコントラストが増加し、

では粒子全体が均一な明コントラストとして現れる。一次電子エネルギー1keV

SEM 装置では像分解能が大幅に

ナノ粒子は再び縁取りを伴った粒子とし

ナノ粒子中心部は Si 基板に対して明らか

な暗コントラストである。また、スキャン方向に平行に線を引いたようなアーティファクトが観察さ

れ、これの条件では、試料帯電が発生していることが示唆される。 

ナノ粒子の計測を行う際には、粒径計測に十分な像分解能

の加速電圧条件が適しているといえる。この条件下では、エッジ効果に

粒子を観察することが可能である。このよ

うなコントラストの粒子像はソフトウェアにより容易に自動粒子解析を行うことが可能であろう。

10-15kV 程度の加速電圧を用

、スキャンスピードや照射電流を

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

）を用いた場合の粒子内コントラストの

SEM 観察用の試料と

装置を用い、一次電子

での条件では二次電子は試料

[図 6.(a)-(l)]。

までの一次電子エネルギー条件では粒子像観察のために必要な分解能を

を印加するリターディング条件で観察を行い、二次電子は

粒子は明コントラストの縁取りをもった粒

基板のそれとほぼ同レベルであることから、

粒子の情報がもたらされていることがわかる。15 keV

にかけて一次電子エネルギーの低下とともに、縁取り内部のコントラストが増加し、

keV でも類似した像

装置では像分解能が大幅に

ナノ粒子は再び縁取りを伴った粒子とし

基板に対して明らか

な暗コントラストである。また、スキャン方向に平行に線を引いたようなアーティファクトが観察さ

ナノ粒子の計測を行う際には、粒径計測に十分な像分解能

の加速電圧条件が適しているといえる。この条件下では、エッジ効果に

粒子を観察することが可能である。このよ

うなコントラストの粒子像はソフトウェアにより容易に自動粒子解析を行うことが可能であろう。

程度の加速電圧を用

、スキャンスピードや照射電流を
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）を用いた場合の粒子内コントラストの 

観察用の試料と

装置を用い、一次電子

での条件では二次電子は試料

。  

までの一次電子エネルギー条件では粒子像観察のために必要な分解能を

を印加するリターディング条件で観察を行い、二次電子は

粒子は明コントラストの縁取りをもった粒

基板のそれとほぼ同レベルであることから、

15 keV から

にかけて一次電子エネルギーの低下とともに、縁取り内部のコントラストが増加し、3keV

でも類似した像

装置では像分解能が大幅に

ナノ粒子は再び縁取りを伴った粒子とし

基板に対して明らか

な暗コントラストである。また、スキャン方向に平行に線を引いたようなアーティファクトが観察さ

ナノ粒子の計測を行う際には、粒径計測に十分な像分解能

の加速電圧条件が適しているといえる。この条件下では、エッジ効果に

粒子を観察することが可能である。このよ

うなコントラストの粒子像はソフトウェアにより容易に自動粒子解析を行うことが可能であろう。 

程度の加速電圧を用

、スキャンスピードや照射電流を  



 

 

 

 

 

 

図 6. 
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6. (a)-(h) PSL
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PSL ナノ粒子の二次電子像コントラストの加速電圧依存性
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ナノ粒子の二次電子像コントラストの加速電圧依存性
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ナノ粒子の二次電子像コントラストの加速電圧依存性
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ナノ粒子の二次電子像コントラストの加速電圧依存性
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ナノ粒子の二次電子像コントラストの加速電圧依存性 
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図 6 の続き） 

図 6. (i)
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6. (i)-(p)  PSL
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(p)  PSL ナノ粒子の二次電子像コントラストの加速電圧依存性
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ナノ粒子の二次電子像コントラストの加速電圧依存性
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ナノ粒子の二次電子像コントラストの加速電圧依存性
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ナノ粒子の二次電子像コントラストの加速電圧依存性
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ナノ粒子の二次電子像コントラストの加速電圧依存性 
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4-1

   

ような理想の形状でない場合が多い。従って、

粒子を２次元に投影した時の、

の面積から求めた円相当径を

    

表

    

の粒子を解析することが望ましい。

 

  4-

     

試験は、

件

比べて

①試料調整方法

②

③画像解析方法

④

⑤粒子径分布

 

 

 

 

 

 

 

 

1-3. 画像解析

 シリカは、比較的、粒子形状が球形に近い。しかし、

ような理想の形状でない場合が多い。従って、

粒子を２次元に投影した時の、

の面積から求めた円相当径を

 RRT では画像解析ソフトの種類、解析方法は各参画機関が選択した。その内容は付録の

表 A.3 に示した。

 解析に要する粒子数の数は、

の粒子を解析することが望ましい。

-1-4. 粒子径分布測定

 ここでは、プロトコル

試験は、2 回行った。

件を下記①～③に示す。

比べて 2 回目の方が

①試料調整方法

各機関の試料調整方法を

②SEM 観察方法

各機関の SEM

③画像解析方法

各機関の画像解析方法は、

④SEM 像 

各機関で測定された

⑤粒子径分布

2 回目 RRT

であった。1

であった。従って、ばら
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画像解析 

シリカは、比較的、粒子形状が球形に近い。しかし、

ような理想の形状でない場合が多い。従って、

粒子を２次元に投影した時の、

の面積から求めた円相当径を

では画像解析ソフトの種類、解析方法は各参画機関が選択した。その内容は付録の

に示した。 

解析に要する粒子数の数は、

の粒子を解析することが望ましい。

粒子径分布測定結果

プロトコルの検討により得られた粒子径分布の実力値を

回行った。1 回目の試験結果を基に

を下記①～③に示す。4

回目の方がばらつき

①試料調整方法 

各機関の試料調整方法を

観察方法 

SEM 観察方法

③画像解析方法 

各機関の画像解析方法は、

各機関で測定された SEM

⑤粒子径分布 

RRT の円相当径分布を

62.4 ±

1 回目の RRT

65.0 ±

った。従って、ばらつきが

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

シリカは、比較的、粒子形状が球形に近い。しかし、

ような理想の形状でない場合が多い。従って、

粒子を２次元に投影した時の、長径である最大

の面積から求めた円相当径を粒子径として測定した。

では画像解析ソフトの種類、解析方法は各参画機関が選択した。その内容は付録の

解析に要する粒子数の数は、500個以上とした。

の粒子を解析することが望ましい。 

結果 

の検討により得られた粒子径分布の実力値を

回目の試験結果を基に

4-1-1 ～ 4-1

ばらつきの少ない結果となった。ここでは、

各機関の試料調整方法を付録の表

観察方法は、付録の表

各機関の画像解析方法は、付録の表

SEM 像の一部を

の円相当径分布を付録の

± 3.0 (1σ)  (

RRT による円相当径の平均値は

± 5.5 (1σ)  (

つきが改善したと言える。
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シリカは、比較的、粒子形状が球形に近い。しかし、

ような理想の形状でない場合が多い。従って、粒子径

長径である最大ｆeret

として測定した。

では画像解析ソフトの種類、解析方法は各参画機関が選択した。その内容は付録の

個以上とした。

の検討により得られた粒子径分布の実力値を

回目の試験結果を基に 2 回目の試験条件を決定した。

1-3 で検討した結果が反映される前の

の少ない結果となった。ここでは、

表 A.1 に示した。

付録の表 A.2 と同じである。

付録の表 A.3 と同じである。

像の一部を付録の図

付録の図 C.2 に示した。

)  (nm) 

円相当径の平均値は

)  (nm) 

改善したと言える。

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

シリカは、比較的、粒子形状が球形に近い。しかし、ナノ粒子は、材料によって必ずしも球の

粒子径をどう測定するかが重要である。そこで、

eret 径、短径である

として測定した。 

では画像解析ソフトの種類、解析方法は各参画機関が選択した。その内容は付録の

個以上とした。粒子径分布が広い試料の場合は、より多く

の検討により得られた粒子径分布の実力値を

回目の試験条件を決定した。

で検討した結果が反映される前の

の少ない結果となった。ここでは、

に示した。 

と同じである。 

と同じである。 

C.1 に示した。

に示した。円相当径の平均値は

円相当径の平均値は、 
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ナノ粒子は、材料によって必ずしも球の

をどう測定するかが重要である。そこで、

径、短径である最小 feret

では画像解析ソフトの種類、解析方法は各参画機関が選択した。その内容は付録の

分布が広い試料の場合は、より多く

の検討により得られた粒子径分布の実力値を RRT 結果

回目の試験条件を決定した。

で検討した結果が反映される前の

の少ない結果となった。ここでは、2 回目の結果を示した。

に示した。 

円相当径の平均値は

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

ナノ粒子は、材料によって必ずしも球の

をどう測定するかが重要である。そこで、

feret 径及び投影面

では画像解析ソフトの種類、解析方法は各参画機関が選択した。その内容は付録の

分布が広い試料の場合は、より多く

結果を用いて示す。

回目の試験条件を決定した。2 回目の試験条

で検討した結果が反映される前の 1 回目の結果

回目の結果を示した。

円相当径の平均値は、 
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ナノ粒子は、材料によって必ずしも球の

をどう測定するかが重要である。そこで、

径及び投影面

では画像解析ソフトの種類、解析方法は各参画機関が選択した。その内容は付録の

分布が広い試料の場合は、より多く

示す。

回目の試験条

の結果に

回目の結果を示した。 



 

 

4-2. 

   シリカナノ粒子と同様に検討した結果を示す。特にチタニアナノ粒子は凝集しやすいため、

如何に分散させるかがポイントとなるため、その詳細を「⑤滴下後処理、乾燥法について」

目に

 

4-2-

①水系分散液の使用と濃度

シリカナノ粒子と同様に濃度は約

②分散液に添加する添加剤

チタニアの場合は、添加剤は使用しなかった。

確認できたためである。

③基板について

シリカナノ粒子と同様である。

④親水化処理

シリカナノ粒子と同様である。

⑤滴下後処理、乾燥法について

  チタニアは、

 ある。

 事例

  試料調製手順は、以下の通りである。

・毛細管ピペット等を使用し、

・

   ・

    

 

 

 

 

 

 

 

 

 

2. チタニアナノ粒子

シリカナノ粒子と同様に検討した結果を示す。特にチタニアナノ粒子は凝集しやすいため、

如何に分散させるかがポイントとなるため、その詳細を「⑤滴下後処理、乾燥法について」

目に示した。 

-1. 試料調製

①水系分散液の使用と濃度

シリカナノ粒子と同様に濃度は約

②分散液に添加する添加剤

チタニアの場合は、添加剤は使用しなかった。

確認できたためである。

③基板について

シリカナノ粒子と同様である。

④親水化処理 

シリカナノ粒子と同様である。

滴下後処理、乾燥法について

チタニアは、分散液を基板に滴下後、

ある。滴下後、すぐに分散液を吸い取らないと凝集

事例 4： 滴下後の濾紙の吸い取り効果について

試料調製手順は、以下の通りである。

・シリコン基板

行った。 

・毛細管ピペット等を使用し、

・10 秒後、濾紙を使用し

（粒子濃度が高い場合には上から濾紙をかぶせる形で、液滴の大部分を吸い取る。

・自然乾燥。 

 この試料の

図 7. 濾紙で滴下
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チタニアナノ粒子 

シリカナノ粒子と同様に検討した結果を示す。特にチタニアナノ粒子は凝集しやすいため、

如何に分散させるかがポイントとなるため、その詳細を「⑤滴下後処理、乾燥法について」

試料調製 

①水系分散液の使用と濃度

シリカナノ粒子と同様に濃度は約

②分散液に添加する添加剤

チタニアの場合は、添加剤は使用しなかった。

確認できたためである。HEC

③基板について 

シリカナノ粒子と同様である。

 

シリカナノ粒子と同様である。

滴下後処理、乾燥法について

分散液を基板に滴下後、

滴下後、すぐに分散液を吸い取らないと凝集

滴下後の濾紙の吸い取り効果について

試料調製手順は、以下の通りである。

・シリコン基板を使用し、

・毛細管ピペット等を使用し、

濾紙を使用し、

粒子濃度が高い場合には上から濾紙をかぶせる形で、液滴の大部分を吸い取る。

 

の SEM 観察画像を

濾紙で滴下 10
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シリカナノ粒子と同様に検討した結果を示す。特にチタニアナノ粒子は凝集しやすいため、

如何に分散させるかがポイントとなるため、その詳細を「⑤滴下後処理、乾燥法について」

①水系分散液の使用と濃度 

シリカナノ粒子と同様に濃度は約 0.1wt%

②分散液に添加する添加剤 

チタニアの場合は、添加剤は使用しなかった。

HEC 添加検討は、未実施である。

シリカナノ粒子と同様である。 

シリカナノ粒子と同様である。 

滴下後処理、乾燥法について 

分散液を基板に滴下後、10

滴下後、すぐに分散液を吸い取らないと凝集

滴下後の濾紙の吸い取り効果について

試料調製手順は、以下の通りである。

使用し、DC プラズマ処理

・毛細管ピペット等を使用し、1μL 程度の極力少量

、液滴を横から吸い取る。

粒子濃度が高い場合には上から濾紙をかぶせる形で、液滴の大部分を吸い取る。

画像を、図 7 に示す。

10 秒後に濾紙で吸い取った場合の

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

シリカナノ粒子と同様に検討した結果を示す。特にチタニアナノ粒子は凝集しやすいため、

如何に分散させるかがポイントとなるため、その詳細を「⑤滴下後処理、乾燥法について」

0.1wt%とした。 

チタニアの場合は、添加剤は使用しなかった。⑤に示す

検討は、未実施である。

10 秒ほど経過したら、濾紙で吸い取ることがポイントで

滴下後、すぐに分散液を吸い取らないと凝集が顕著になる。

滴下後の濾紙の吸い取り効果について 

試料調製手順は、以下の通りである。 

プラズマ処理を 2min

程度の極力少量

液滴を横から吸い取る。

粒子濃度が高い場合には上から濾紙をかぶせる形で、液滴の大部分を吸い取る。

に示す。 

秒後に濾紙で吸い取った場合の

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

シリカナノ粒子と同様に検討した結果を示す。特にチタニアナノ粒子は凝集しやすいため、

如何に分散させるかがポイントとなるため、その詳細を「⑤滴下後処理、乾燥法について」

 

に示す滴下後処理、乾燥法の

検討は、未実施である。 

秒ほど経過したら、濾紙で吸い取ることがポイントで

が顕著になる。

2min（使用装置 

程度の極力少量を滴下した

液滴を横から吸い取る。 

粒子濃度が高い場合には上から濾紙をかぶせる形で、液滴の大部分を吸い取る。

秒後に濾紙で吸い取った場合の SEM
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シリカナノ粒子と同様に検討した結果を示す。特にチタニアナノ粒子は凝集しやすいため、

如何に分散させるかがポイントとなるため、その詳細を「⑤滴下後処理、乾燥法について」

滴下後処理、乾燥法の

秒ほど経過したら、濾紙で吸い取ることがポイントで

が顕著になる。（事例 4 参照

日本電子製: 

した。 

粒子濃度が高い場合には上から濾紙をかぶせる形で、液滴の大部分を吸い取る。

SEM 画像（X30k , 2kV

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

シリカナノ粒子と同様に検討した結果を示す。特にチタニアナノ粒子は凝集しやすいため、

如何に分散させるかがポイントとなるため、その詳細を「⑤滴下後処理、乾燥法について」

滴下後処理、乾燥法の効果が 

秒ほど経過したら、濾紙で吸い取ることがポイントで

参照） 

: HDT-400） 

粒子濃度が高い場合には上から濾紙をかぶせる形で、液滴の大部分を吸い取る。） 

X30k , 2kV）  
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シリカナノ粒子と同様に検討した結果を示す。特にチタニアナノ粒子は凝集しやすいため、 

如何に分散させるかがポイントとなるため、その詳細を「⑤滴下後処理、乾燥法について」の項

 

秒ほど経過したら、濾紙で吸い取ることがポイントで 

 

 

 



 

 

   次に、

なる傾向になる

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

         

(a)

(b)

                

(c)

(d)

 

 

 

 

 

 

 

 

次に、滴下後、すぐに吸い取らない場合の例を

なる傾向になる

           

(a) シリコン基板

(b) 基板上に分散液滴下後、乾燥

                

(c) 親水処理した鏡面

d) ポリビニルブチラール支持膜付き

水分を蒸発
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滴下後、すぐに吸い取らない場合の例を

なる傾向になることがわかる。

                        

シリコン基板 10 分 プラズマ処理。分散液

(×100

分散液滴下後、乾燥

                (×

親水処理した鏡面 Si 基板に分散液を

ポリビニルブチラール支持膜付き

水分を蒸発  (×100k, 

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

滴下後、すぐに吸い取らない場合の例を

ことがわかる。 

                

図 8. 滴下後、吸い取らない例

プラズマ処理。分散液

100k,  0.5kV

分散液滴下後、乾燥 

×300k,  3kV) 

基板に分散液を

ポリビニルブチラール支持膜付き Cu

,  3kV) 

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

滴下後、すぐに吸い取らない場合の例を図

                  (b)               

滴下後、吸い取らない例

 

プラズマ処理。分散液 約

0.5kV) 

) 

基板に分散液を 0.2uL 滴下し，室温で乾燥

Cu メッシュに分散液

(a)                                  (b)

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

図 8 に示す。図

                

滴下後、吸い取らない例 

約 10uL 滴下後、

滴下し，室温で乾燥

メッシュに分散液 7μL

(a)                                  (b)

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

図 7 に比べ、凝集が多

 

滴下後、自然乾燥 

滴下し，室温で乾燥 (×50k,  

L 滴下し、105

(a)                                  (b)

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

に比べ、凝集が多く 

 

0k,  5kV) 

105℃の乾燥機で

(a)                                  (b) 

 

 14 
Copyright © Nanotechnology Business Creation Initiative. All rights reserved 

 

℃の乾燥機で 

 



 

 

4-2-

基本的

4-2-

基本的には、

4-2-

プロトコルの検討により得られた粒子径分布測定の

2

1

①試料調整方法

②

③画像解析方法

④

⑤粒子径分布

1

であり、

 

4-3. 

  4-

大きく依存しないとの想定で行った。

  本項目では、画像解析が粒子径分布に与える影響を調査することを目的に、同一画像を

た複数機関

画像を検討した。その結果、凝集性の違いにより画像解析の影響が異なることが確認されたが、

凝集の多い画像においても解析方法を工夫することにより粒子径分布が改善されることが確認

された。

 

4-3-

  検討した代表的な画像を

多い画像、図

 

 

-2. SEM 観察

基本的には、シリカナノ粒子と同様である。

-3. 画像解析

基本的には、シリカナノ粒子と同様である。

-4.粒子径分布測定

プロトコルの検討により得られた粒子径分布測定の

2回目の試験条件を下記①～③に示す。

1 回目の結果に比べて

①試料調整方法

各機関の試料調整方法を

②SEM 観察方法

各機関の

③画像解析方法

各機関の画像解析方法

④SEM 像 

各機関で測定された

⑤粒子径分布

2 回目の RRT

1 回目円相当径の平均値は

であり、ばらつきが改善された

3. 凝集、分散状態の異なる画像の粒子径分布計測結果比較と画像解析改善

-1 および 4-2

大きく依存しないとの想定で行った。

本項目では、画像解析が粒子径分布に与える影響を調査することを目的に、同一画像を

複数機関による

画像を検討した。その結果、凝集性の違いにより画像解析の影響が異なることが確認されたが、

凝集の多い画像においても解析方法を工夫することにより粒子径分布が改善されることが確認

された。 

-1. シリカ検討画像

検討した代表的な画像を

多い画像、図 9.(B)
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観察 

シリカナノ粒子と同様である。

画像解析 

シリカナノ粒子と同様である。

粒子径分布測定結果 

プロトコルの検討により得られた粒子径分布測定の

回目の試験条件を下記①～③に示す。

回目の結果に比べて 2

①試料調整方法 

各機関の試料調整方法を

観察方法 

SEM 観察方法

③画像解析方法 

各機関の画像解析方法

各機関で測定された SEM

⑤粒子径分布 

RRT の円相当径

36.8 ± 

回目円相当径の平均値は

36.1 ± 

らつきが改善された

凝集、分散状態の異なる画像の粒子径分布計測結果比較と画像解析改善

2 の RRT では計測結果は試料調整法の影響を受けるが、画像解析の方法に

大きく依存しないとの想定で行った。

本項目では、画像解析が粒子径分布に与える影響を調査することを目的に、同一画像を

による画像解析の

画像を検討した。その結果、凝集性の違いにより画像解析の影響が異なることが確認されたが、

凝集の多い画像においても解析方法を工夫することにより粒子径分布が改善されることが確認

検討画像 

検討した代表的な画像を図

.(B)はその中間的な凝集を示している。
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シリカナノ粒子と同様である。

シリカナノ粒子と同様である。

 

プロトコルの検討により得られた粒子径分布測定の

回目の試験条件を下記①～③に示す。

2 回目の方が

各機関の試料調整方法を付録の表

観察方法は、付録の表

各機関の画像解析方法は、付録の表

SEM 像の一部を

円相当径分布を付録の図

 6.3 (１σ)  (

回目円相当径の平均値は、 

 10.6 (１σ)  

らつきが改善された。 

凝集、分散状態の異なる画像の粒子径分布計測結果比較と画像解析改善

では計測結果は試料調整法の影響を受けるが、画像解析の方法に

大きく依存しないとの想定で行った。 

本項目では、画像解析が粒子径分布に与える影響を調査することを目的に、同一画像を

画像解析の RRT 試験を行った。具体的には、シリカナノ粒子の凝集の異なる

画像を検討した。その結果、凝集性の違いにより画像解析の影響が異なることが確認されたが、

凝集の多い画像においても解析方法を工夫することにより粒子径分布が改善されることが確認

図9 に示す。図

はその中間的な凝集を示している。
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シリカナノ粒子と同様である。事例を付録の表

シリカナノ粒子と同様である。事例を付録の表

プロトコルの検討により得られた粒子径分布測定の

回目の試験条件を下記①～③に示す。4-2-1から

回目の方がばらつきの少ない結果となった。

付録の表 B.1 に示した。

、付録の表 B.2 と同じである。

付録の表 B.3 と同じである。

像の一部を付録の図

付録の図 D.2

)  (nm)であった。

  (nm) 

凝集、分散状態の異なる画像の粒子径分布計測結果比較と画像解析改善

では計測結果は試料調整法の影響を受けるが、画像解析の方法に

本項目では、画像解析が粒子径分布に与える影響を調査することを目的に、同一画像を

試験を行った。具体的には、シリカナノ粒子の凝集の異なる

画像を検討した。その結果、凝集性の違いにより画像解析の影響が異なることが確認されたが、

凝集の多い画像においても解析方法を工夫することにより粒子径分布が改善されることが確認

に示す。図 9.(A) は凝集が非常に少ない画像、図

はその中間的な凝集を示している。
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付録の表 B.2

付録の表 B.3

プロトコルの検討により得られた粒子径分布測定の RRT 結果を示す。試験は、

から4-2-3で検討した結果が反映される前の

の少ない結果となった。

に示した。 

と同じである。 

と同じである。 

図 D.1 に示した。

2 に示した。円相当径の平均値は

であった。 

凝集、分散状態の異なる画像の粒子径分布計測結果比較と画像解析改善

では計測結果は試料調整法の影響を受けるが、画像解析の方法に

本項目では、画像解析が粒子径分布に与える影響を調査することを目的に、同一画像を

試験を行った。具体的には、シリカナノ粒子の凝集の異なる

画像を検討した。その結果、凝集性の違いにより画像解析の影響が異なることが確認されたが、

凝集の多い画像においても解析方法を工夫することにより粒子径分布が改善されることが確認

は凝集が非常に少ない画像、図

はその中間的な凝集を示している。 
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B.2 に示す。 

B.3 に示す。 

結果を示す。試験は、

で検討した結果が反映される前の

の少ない結果となった。 

に示した。 

円相当径の平均値は

凝集、分散状態の異なる画像の粒子径分布計測結果比較と画像解析改善

では計測結果は試料調整法の影響を受けるが、画像解析の方法に

本項目では、画像解析が粒子径分布に与える影響を調査することを目的に、同一画像を

試験を行った。具体的には、シリカナノ粒子の凝集の異なる

画像を検討した。その結果、凝集性の違いにより画像解析の影響が異なることが確認されたが、

凝集の多い画像においても解析方法を工夫することにより粒子径分布が改善されることが確認

は凝集が非常に少ない画像、図

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

結果を示す。試験は、2 回行った。

で検討した結果が反映される前の

円相当径の平均値は、 

凝集、分散状態の異なる画像の粒子径分布計測結果比較と画像解析改善 

では計測結果は試料調整法の影響を受けるが、画像解析の方法に

本項目では、画像解析が粒子径分布に与える影響を調査することを目的に、同一画像を

試験を行った。具体的には、シリカナノ粒子の凝集の異なる

画像を検討した。その結果、凝集性の違いにより画像解析の影響が異なることが確認されたが、

凝集の多い画像においても解析方法を工夫することにより粒子径分布が改善されることが確認

は凝集が非常に少ない画像、図 9.(C)は凝集が
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回行った。  

で検討した結果が反映される前の

では計測結果は試料調整法の影響を受けるが、画像解析の方法に 

本項目では、画像解析が粒子径分布に与える影響を調査することを目的に、同一画像を用い

試験を行った。具体的には、シリカナノ粒子の凝集の異なる

画像を検討した。その結果、凝集性の違いにより画像解析の影響が異なることが確認されたが、

凝集の多い画像においても解析方法を工夫することにより粒子径分布が改善されることが確認

は凝集が



 

 

 

 

 

 

 

 

 

    

 

 

 

 

 

 

 

                             

 

 

 

 

 

 

 

         

 

 4-3-

 ①画像解析方法

粒子数

②粒子径分布

    

示す。

  

  

                     

                             

                                      

-2. 画像解析比較

①画像解析方法

各機関の画像解析方法を表

粒子数 500 個以上を解析した結果である。

②粒子径分布 

 各機関で画像解析して得られた最大ｆ

示す。 
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図 9. 解析対象とした

画像解析比較結果  

①画像解析方法 

各機関の画像解析方法を表

個以上を解析した結果である。

 

各機関で画像解析して得られた最大ｆ
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解析対象とした

 

各機関の画像解析方法を表 1 に示した。各画像セットは、図

個以上を解析した結果である。

各機関で画像解析して得られた最大ｆ
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             A 

                             B 

                             C 

解析対象としたシリカの３種類の

に示した。各画像セットは、図

個以上を解析した結果である。 

各機関で画像解析して得られた最大ｆeret 径、最小

 

 

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

３種類の代表 SEM

に示した。各画像セットは、図

径、最小 feret 径及び円相当径を図

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

SEM 画像 

に示した。各画像セットは、図 9 の画像を含め

径及び円相当径を図

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

の画像を含め 12 枚を用い、

径及び円相当径を図 10～図
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枚を用い、

図 12 に



 

 

機関 解析ソフト
a Fiji ver2

b
Photoshop7.0

粒子解析 Ver3.5

c
ImageJ　1.50e

Image Jプラグイン

d

Image-Pro

Premier v9.3.2

(日本ローパー製

e Ｗｉｎ ROOF ver.3.5

f SPIP Ver.6.7.2

(画像A）

ImageJ 1.51n

(画像B）

EDSION-v1.1

 セグメンテーション
OpenCV v2.4.8

 輪郭検出、粒径算

出
ImageJ 1.51n

(画像C）

OpenCV v2.4.8

h

Image-Pro

Premier

Ver.9.2

i
ImageJ

Ver.1.50i

j

Fiji 1.0 (ImageJ

1.51n)

ParticleSizer 1.09

g

解析ソフト 処理内容
1median   2

Photoshop7.0

 Ver3.5

1.画像前処理：
2.Photoshop

3.粒子解析ソフトによる２値化
4.粒子解析ソフトにより自動計測

1.50e

プラグイン

1.ノイズ除去

・モード: Fiji,  Spatial: 3 , Range: 50

2.２値化処理　　大津の２値化
3.粒子分離処理

・二値化画像に対してエロージョン演算を繰り返し
行い粒子を分離

（画像A）18

エロージョン演算結果に対してボロノイ図作成。
ボロノイ図と二値化画像を

Image-Pro

Premier v9.3.2

日本ローパー製)

① 画像前処理：メディアンフィルター（

② バンドパスフィルター

（ローサイズ

③ 大津の自動

④ 凹凸部による自動分割

 ROOF ver.3.5

1.前処理：

　平均化処理（フィルタサイズ
2.二値化：モード法
3.円形分離
4.計測（1回目）
5.二値化条件により小粒子数え落としあるため、

　再度閾値を変更して二値化

6.面積フィルタで大粒子排除

7.計測（2回目）

SPIP Ver.6.7.2

形状直径範囲：

勾配閾値：

ノイズフィルタ：

許容される重複：

感度：-5

ImageJ 1.51n

ノイズ低減
　Process/Filters/Gaussian Blur - 5 pixel

2値化

　Image/Adjust/Threshold - 

セグメンテーション
　Process/Binary/watershed

EDSION-v1.1

セグメンテーション
OpenCV v2.4.8

輪郭検出、粒径算

ImageJ 1.51n

EDISONによるセグメンテーション

　MeanShift:

　　kernel - uniform, space window- 20pixel,

　　color window- 15pixel, Min region - 200pixel

　Weight Map

　Gradiation windwow - 5pixel

粒径算出
　OpenCV minAreaRect

OpenCV v2.4.8

ノイズ低減
2値化：Thresshold(80

ノイズ低減

セグメンテーション：
(maskの

閾値 0.3近傍

粒径算出：

Image-Pro
背景と粒子の平均輝度の中間点を閾値とし、
IPPカウント機能により粒形抽出（画像輝度のヒス

トグラムをガウスフィッティングすることによりそれ
ぞれの平均輝度を算出）

１．画像を

２．解析領域の指定（スケールバーや文字などの
削除）
３．二値化
４．メディアンフィルタ

５．Watershed

６．輪郭抽出

Fiji 1.0 (ImageJ

ParticleSizer 1.09

Single particle mode,

Watershed for irregular structures, threshold

convexity =0.95

Area >500px

(画像C minimum solidity=0.5)

Min Feret > 16 px(

他のパラメータは
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1median   2大津で２値化   3 Watershed

画像前処理：photoshopによる自動輪郭抽出
2.Photoshopによる接触粒子の切り離し

粒子解析ソフトによる２値化

粒子解析ソフトにより自動計測

ノイズ除去: バイラテラルフィルタ
: Fiji,  Spatial: 3 , Range: 50

２値化処理　　大津の２値化

粒子分離処理

・二値化画像に対してエロージョン演算を繰り返し
行い粒子を分離

18回、（画像B）12回、

エロージョン演算結果に対してボロノイ図作成。
ボロノイ図と二値化画像をOR演算し、粒子を分離

画像前処理：メディアンフィルター（

バンドパスフィルター

（ローサイズ1、ハイサイズ10、強さ

大津の自動2値化（閾値110

凹凸部による自動分割

前処理：γ補正（γ値0.5、画像

　平均化処理（フィルタサイズ5×5

二値化：モード法

円形分離

回目）

二値化条件により小粒子数え落としあるため、

　再度閾値を変更して二値化(画像

面積フィルタで大粒子排除(画像

回目） (画像B）
形状直径範囲：20nm～300nm

勾配閾値：0.6 （画像B 1.2)Arbitrary

ノイズフィルタ：4ピクセル（画像

許容される重複：20％

ノイズ低減
Process/Filters/Gaussian Blur - 5 pixel

Image/Adjust/Threshold - （ほぼ

セグメンテーション
Process/Binary/watershed

によるセグメンテーション
MeanShift:パラメータ

kernel - uniform, space window- 20pixel,

color window- 15pixel, Min region - 200pixel

Weight Mapパラメータ
Gradiation windwow - 5pixel

OpenCV minAreaRect

ノイズ低減 1：Gaussian Blur - 3pixel

Thresshold(80近傍)

ノイズ低減 2：Opening/Dilation - 3pixel

セグメンテーション：dist_transform

近傍)

粒径算出：minAreaRect

背景と粒子の平均輝度の中間点を閾値とし、
カウント機能により粒形抽出（画像輝度のヒス

トグラムをガウスフィッティングすることによりそれ
ぞれの平均輝度を算出）

１．画像を 8bitグレイスケールに変換

２．解析領域の指定（スケールバーや文字などの

３．二値化
４．メディアンフィルタ(2 px)によるノイズ除去

Watershed

６．輪郭抽出
Single particle mode,

Watershed for irregular structures, threshold

convexity =0.95

Area >500px
2
 (画像B,C 75 px

 minimum solidity=0.5)

Min Feret > 16 px(画像B,C なし）

他のパラメータはas Default
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輪郭抽出の方式
   3 Watershedで分離 watershed  

による自動輪郭抽出

による接触粒子の切り離し

粒子解析ソフトにより自動計測

粒子解析ソフト
自動計測処理

バイラテラルフィルタ
: Fiji,  Spatial: 3 , Range: 50 (画像A 90)

・二値化画像に対してエロージョン演算を繰り返し

回、（画像C）9回

エロージョン演算結果に対してボロノイ図作成。
演算し、粒子を分離

・自作プログラム　

・二値化により、背景と前景（粒子）に分離した画
像を読込む

・前景をラベリングし、背景とラベリングした領域の
境界を輪郭として取得　輪郭の内側を粒子として
計算。

画像前処理：メディアンフィルター（3×3)

、強さ10、回数1）
110～255）

画像C 0.3)、

5×5）

二値化条件により小粒子数え落としあるため、

画像B）

画像B）

・絶対最大長→最大

・対角幅→最小

300nm

 1.2)Arbitrary

画像B,C  10ピクセル) 円検出（

Process/Filters/Gaussian Blur - 5 pixel

（ほぼ)default

によるセグメンテーション

kernel - uniform, space window- 20pixel,

color window- 15pixel, Min region - 200pixel

Gaussian Blur - 3pixel

Opening/Dilation - 3pixel

dist_transform、watershed

背景と粒子の平均輝度の中間点を閾値とし、
カウント機能により粒形抽出（画像輝度のヒス

トグラムをガウスフィッティングすることによりそれ

IPP

　連結

　自動

散法

　面積

　円周（面積から算出）／輪郭＜

子と見なして除外
グレイスケールに変換

２．解析領域の指定（スケールバーや文字などの

によるノイズ除去
ImageJ

Watershed for irregular structures, threshold

 75 px
2
), solidity > 0.5

 minimum solidity=0.5)

なし）

OpenCV findcontour

表
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輪郭抽出の方式
watershed  

粒子解析ソフト
自動計測処理

・自作プログラム　OpenCV3.1

・二値化により、背景と前景（粒子）に分離した画
像を読込む

・前景をラベリングし、背景とラベリングした領域の
境界を輪郭として取得　輪郭の内側を粒子として
計算。

・絶対最大長→最大 Feret

・対角幅→最小Feret 

円検出（Circle Detection

IPPでのカウントの測定オプション

　連結: 8連結、境界上を除外

　自動2値化のバイアス

散法 平滑化: 10、拡大

　面積: 78nm
2
（直径10nm

　円周（面積から算出）／輪郭＜

子と見なして除外

ImageJ　Particle Analysis

OpenCV findcontour

 

表 1. 画像解析法
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OpenCV3.1ライブラリ使用

・二値化により、背景と前景（粒子）に分離した画

・前景をラベリングし、背景とラベリングした領域の
境界を輪郭として取得　輪郭の内側を粒子として

-

 Feret径
Feret 径 相当とて報告

Circle Detection）法粒子検出

でのカウントの測定オプション

連結、境界上を除外: 全て 穴埋め

値化のバイアス: 0、自動2値化: 最小分

、拡大: 0、自動分割: 無し

10nm）以下を除外

　円周（面積から算出）／輪郭＜0.95　を凝集粒

Particle Analysis

-

画像解析法  
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フィルタ条件

円形度が0.8

写真端部で切れた粒子は計測対象外

ライブラリ使用

・二値化により、背景と前景（粒子）に分離した画

・前景をラベリングし、背景とラベリングした領域の
境界を輪郭として取得　輪郭の内側を粒子として

面積　1200nm

不規則度（最大内接円

の粒子を排除

面積400nm
2

・ピクセル=1x1

・面積>400の粒子を排除

・得られた輪郭が実際の画像と一致しない箇所
を手動で排除

イメージの端を含む面積

除

・30nm以下のサイズで異常形

・顕著な凹形

上記を目視により削除
・画像の端(エッジ

穴埋め

最小分

　を凝集粒

面積: 78nm
2

円周（面積から算出）／輪郭＜

と見なして除外

像C) 自動分割のオプション：カウント時に測定図

形を分割、分割方法
40

・面積＜50nm

異常分割された輪郭を目視で除外

の処理なし）

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

以上の粒子を抽出

写真端部で切れた粒子は計測対象外

1200nm
2
以下の粒子を排除

不規則度（最大内接円/最大フェレ径）　

の粒子を排除

2
以下を除外

=1x1排除(6の時)

の粒子を排除

・得られた輪郭が実際の画像と一致しない箇所
を手動で排除

イメージの端を含む面積300nm
2
以下の粒子を排

-

以下のサイズで異常形

・顕著な凹形(ヒョウタン形等)

上記を目視により削除
エッジ)に接触する粒子は削除

-

2
（直径10nm）以下を除外

円周（面積から算出）／輪郭＜0.95

と見なして除外                                              

自動分割のオプション：カウント時に測定図

形を分割、分割方法: Watershed、凹部サイズ

50nm
2
 の粒子を排除

異常分割された輪郭を目視で除外
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写真端部で切れた粒子は計測対象外

以下の粒子を排除

最大フェレ径）　0.5以下

・得られた輪郭が実際の画像と一致しない箇所

以下の粒子を排

に接触する粒子は削除

）以下を除外
0.95　を凝集粒子

                                              (画

自動分割のオプション：カウント時に測定図

、凹部サイズ:

異常分割された輪郭を目視で除外(画像B,Cはこ

 

 

 

 

 

 

 



 

 

          

 

 

 

 

 

 

 

 

 

 

 

 

 

 

図 10. 画像

          図中の記号
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画像 A の各解析方法に対する最大

図中の記号 a～

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

の各解析方法に対する最大

～j は、表１の機関に対応

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

 

の各解析方法に対する最大 Feret

は、表１の機関に対応

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

Feret 径、円相当径、最少

は、表１の機関に対応。以下の図

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

径、円相当径、最少

。以下の図 11,図 12 も同様。
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a 

b 

c 

d

a 
e 

f 

h 

g 

i 

j 

径、円相当径、最少 Feret 径 

も同様。 
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図 11

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

図 12
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11. 画像 B の各解析方法に対する最大

12. 画像 C の各解析方法に対する最大
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の各解析方法に対する最大

の各解析方法に対する最大

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

の各解析方法に対する最大

の各解析方法に対する最大

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

の各解析方法に対する最大 Feret 径、円相当径、最少

の各解析方法に対する最大 Feret 径、円相当径、最少

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

径、円相当径、最少

径、円相当径、最少

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

径、円相当径、最少 Feret 径 

径、円相当径、最少 Feret 径 
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a 

b 

c 

d

a 
e 

f 

h 

g 

i 

j 

a 

b 

c 

d

e 

f 

h 

g 

i 
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  となった。画像

C

ストが暗くなる影響で、輪郭が内側にとられ、空隙ができたように見える。そのため、みかけの

粒子が小さく算出されてしまう。さらに、粒子内コントラストの影響で、複数の粒子を分割してし

まう誤分割や一つの粒子自体をより小さく見積もってしまう誤検出が原因である。その他、重

なり粒子を一つの粒子として検出しまう場合もある。これらにより、平均

た

の形状は大きく異なっているものが見られる。特に粒子径の小さい方へ分布が引きずられた

ものが目立つので、粒子の面積や形状などのフィルタでノイズや異物を排除することも必要で

あると考えられる。
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ら、

①画像解析方法

    

分割を生じる。輪郭を内側にとらないこと、誤分割、誤検出を減らすことによる改善が可能かを

調べた。

れた点を記載した

る輪郭抽出を新たな画像解析ソフトの導入により行なう方法

直したり

法を取り入れていることなど高度化している

   

各画像セットの上記の円相当径の全体の平均値とばらつきは、

画像

画像

画像

となった。画像

C は、平均値が

画像 C の粒子径

ストが暗くなる影響で、輪郭が内側にとられ、空隙ができたように見える。そのため、みかけの

粒子が小さく算出されてしまう。さらに、粒子内コントラストの影響で、複数の粒子を分割してし

まう誤分割や一つの粒子自体をより小さく見積もってしまう誤検出が原因である。その他、重

なり粒子を一つの粒子として検出しまう場合もある。これらにより、平均

た粒子径分布ばらつきが大きくなると考えられる。

一方、平均粒子径が良く一致している画像

の形状は大きく異なっているものが見られる。特に粒子径の小さい方へ分布が引きずられた

ものが目立つので、粒子の面積や形状などのフィルタでノイズや異物を排除することも必要で

あると考えられる。

3. 画像解析の再検討とその結果

 図 9.の画像

ら、再試験を実施した。

①画像解析方法

 凝集が画像全体に多くなると、粒子重なり部及び粒子内部のコントラストにより、誤検出、

分割を生じる。輪郭を内側にとらないこと、誤分割、誤検出を減らすことによる改善が可能かを

調べた。各機関の画像解析方法を表

れた点を記載した

る輪郭抽出を新たな画像解析ソフトの導入により行なう方法

直したり(機関

法を取り入れていることなど高度化している

 表 1,表 2 には記載されていない画像解析手順の詳細については、付録
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各画像セットの上記の円相当径の全体の平均値とばらつきは、

画像 A    62.7

画像 B    63.4

画像 C    58.3

となった。画像 A,B は、ほぼ同じ値になり、ばらつきも１ピクセル相当になっている。一方、画像

は、平均値が A,B より小さく、ばらつきが数倍大きい結果となった。

粒子径が小さくなる理由としては、図

ストが暗くなる影響で、輪郭が内側にとられ、空隙ができたように見える。そのため、みかけの

粒子が小さく算出されてしまう。さらに、粒子内コントラストの影響で、複数の粒子を分割してし

まう誤分割や一つの粒子自体をより小さく見積もってしまう誤検出が原因である。その他、重

なり粒子を一つの粒子として検出しまう場合もある。これらにより、平均

分布ばらつきが大きくなると考えられる。

一方、平均粒子径が良く一致している画像

の形状は大きく異なっているものが見られる。特に粒子径の小さい方へ分布が引きずられた

ものが目立つので、粒子の面積や形状などのフィルタでノイズや異物を排除することも必要で

あると考えられる。 

図 13.

画像解析の再検討とその結果

画像 C において、他の画像

再試験を実施した。 

①画像解析方法  

凝集が画像全体に多くなると、粒子重なり部及び粒子内部のコントラストにより、誤検出、

分割を生じる。輪郭を内側にとらないこと、誤分割、誤検出を減らすことによる改善が可能かを

各機関の画像解析方法を表

れた点を記載した。表 1 と比較すると、輪郭抽出を

る輪郭抽出を新たな画像解析ソフトの導入により行なう方法

機関 a,c,g,i)、誤検出を避けるために目視で手動による排除をする

法を取り入れていることなど高度化している

には記載されていない画像解析手順の詳細については、付録
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各画像セットの上記の円相当径の全体の平均値とばらつきは、

A    62.7±1.8 (1σ)  (

B    63.4±2.7 (1σ)  (

C    58.3±5.2 (1σ) 

は、ほぼ同じ値になり、ばらつきも１ピクセル相当になっている。一方、画像

より小さく、ばらつきが数倍大きい結果となった。

が小さくなる理由としては、図

ストが暗くなる影響で、輪郭が内側にとられ、空隙ができたように見える。そのため、みかけの

粒子が小さく算出されてしまう。さらに、粒子内コントラストの影響で、複数の粒子を分割してし

まう誤分割や一つの粒子自体をより小さく見積もってしまう誤検出が原因である。その他、重

なり粒子を一つの粒子として検出しまう場合もある。これらにより、平均

分布ばらつきが大きくなると考えられる。

一方、平均粒子径が良く一致している画像

の形状は大きく異なっているものが見られる。特に粒子径の小さい方へ分布が引きずられた

ものが目立つので、粒子の面積や形状などのフィルタでノイズや異物を排除することも必要で

. 凝集が多い場合の誤分割、誤検出

画像解析の再検討とその結果 

において、他の画像 A,B

凝集が画像全体に多くなると、粒子重なり部及び粒子内部のコントラストにより、誤検出、

分割を生じる。輪郭を内側にとらないこと、誤分割、誤検出を減らすことによる改善が可能かを

各機関の画像解析方法を表 2

と比較すると、輪郭抽出を

る輪郭抽出を新たな画像解析ソフトの導入により行なう方法

、誤検出を避けるために目視で手動による排除をする

法を取り入れていることなど高度化している

には記載されていない画像解析手順の詳細については、付録
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各画像セットの上記の円相当径の全体の平均値とばらつきは、

)  (nm) 

)  (nm) 

)  (nm) 

は、ほぼ同じ値になり、ばらつきも１ピクセル相当になっている。一方、画像

より小さく、ばらつきが数倍大きい結果となった。

が小さくなる理由としては、図 13

ストが暗くなる影響で、輪郭が内側にとられ、空隙ができたように見える。そのため、みかけの

粒子が小さく算出されてしまう。さらに、粒子内コントラストの影響で、複数の粒子を分割してし

まう誤分割や一つの粒子自体をより小さく見積もってしまう誤検出が原因である。その他、重

なり粒子を一つの粒子として検出しまう場合もある。これらにより、平均

分布ばらつきが大きくなると考えられる。 

一方、平均粒子径が良く一致している画像 A、B においても、図

の形状は大きく異なっているものが見られる。特に粒子径の小さい方へ分布が引きずられた

ものが目立つので、粒子の面積や形状などのフィルタでノイズや異物を排除することも必要で

凝集が多い場合の誤分割、誤検出

A,B よりも平均粒径とそのばらつきが大きくなった

凝集が画像全体に多くなると、粒子重なり部及び粒子内部のコントラストにより、誤検出、

分割を生じる。輪郭を内側にとらないこと、誤分割、誤検出を減らすことによる改善が可能かを

2 に示した（機関数は

と比較すると、輪郭抽出を 2

る輪郭抽出を新たな画像解析ソフトの導入により行なう方法

、誤検出を避けるために目視で手動による排除をする

法を取り入れていることなど高度化していることがわかる。

には記載されていない画像解析手順の詳細については、付録
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各画像セットの上記の円相当径の全体の平均値とばらつきは、

は、ほぼ同じ値になり、ばらつきも１ピクセル相当になっている。一方、画像

より小さく、ばらつきが数倍大きい結果となった。

13 に示すように、粒子の重なり部のコントラ

ストが暗くなる影響で、輪郭が内側にとられ、空隙ができたように見える。そのため、みかけの

粒子が小さく算出されてしまう。さらに、粒子内コントラストの影響で、複数の粒子を分割してし

まう誤分割や一つの粒子自体をより小さく見積もってしまう誤検出が原因である。その他、重

なり粒子を一つの粒子として検出しまう場合もある。これらにより、平均

 

においても、図

の形状は大きく異なっているものが見られる。特に粒子径の小さい方へ分布が引きずられた

ものが目立つので、粒子の面積や形状などのフィルタでノイズや異物を排除することも必要で

凝集が多い場合の誤分割、誤検出の

よりも平均粒径とそのばらつきが大きくなった

凝集が画像全体に多くなると、粒子重なり部及び粒子内部のコントラストにより、誤検出、

分割を生じる。輪郭を内側にとらないこと、誤分割、誤検出を減らすことによる改善が可能かを

（機関数は 2 機関減少）

2 段階処理したり

る輪郭抽出を新たな画像解析ソフトの導入により行なう方法(機関

、誤検出を避けるために目視で手動による排除をする

ことがわかる。 

には記載されていない画像解析手順の詳細については、付録
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各画像セットの上記の円相当径の全体の平均値とばらつきは、 

は、ほぼ同じ値になり、ばらつきも１ピクセル相当になっている。一方、画像

より小さく、ばらつきが数倍大きい結果となった。 

に示すように、粒子の重なり部のコントラ

ストが暗くなる影響で、輪郭が内側にとられ、空隙ができたように見える。そのため、みかけの

粒子が小さく算出されてしまう。さらに、粒子内コントラストの影響で、複数の粒子を分割してし

まう誤分割や一つの粒子自体をより小さく見積もってしまう誤検出が原因である。その他、重

なり粒子を一つの粒子として検出しまう場合もある。これらにより、平均粒子径

においても、図 10．や図 11

の形状は大きく異なっているものが見られる。特に粒子径の小さい方へ分布が引きずられた

ものが目立つので、粒子の面積や形状などのフィルタでノイズや異物を排除することも必要で

の事例 

よりも平均粒径とそのばらつきが大きくなった

凝集が画像全体に多くなると、粒子重なり部及び粒子内部のコントラストにより、誤検出、

分割を生じる。輪郭を内側にとらないこと、誤分割、誤検出を減らすことによる改善が可能かを

機関減少）。表

段階処理したり（機関 g,h

機関 j)、形状フィルタの条件を見

、誤検出を避けるために目視で手動による排除をする(機関

には記載されていない画像解析手順の詳細については、付録 E
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は、ほぼ同じ値になり、ばらつきも１ピクセル相当になっている。一方、画像

に示すように、粒子の重なり部のコントラ

ストが暗くなる影響で、輪郭が内側にとられ、空隙ができたように見える。そのため、みかけの

粒子が小さく算出されてしまう。さらに、粒子内コントラストの影響で、複数の粒子を分割してし

まう誤分割や一つの粒子自体をより小さく見積もってしまう誤検出が原因である。その他、重

粒子径が小さくなり、ま

．や図 11．の粒子径分布

の形状は大きく異なっているものが見られる。特に粒子径の小さい方へ分布が引きずられた

ものが目立つので、粒子の面積や形状などのフィルタでノイズや異物を排除することも必要で

よりも平均粒径とそのばらつきが大きくなったことか

凝集が画像全体に多くなると、粒子重なり部及び粒子内部のコントラストにより、誤検出、

分割を生じる。輪郭を内側にとらないこと、誤分割、誤検出を減らすことによる改善が可能かを

表 1 に対して変更さ

g,h）、機械学習によ

、形状フィルタの条件を見

機関 b,g,i)などの方

E にいくつかの事例
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は、ほぼ同じ値になり、ばらつきも１ピクセル相当になっている。一方、画像

に示すように、粒子の重なり部のコントラ

ストが暗くなる影響で、輪郭が内側にとられ、空隙ができたように見える。そのため、みかけの

粒子が小さく算出されてしまう。さらに、粒子内コントラストの影響で、複数の粒子を分割してし

まう誤分割や一つの粒子自体をより小さく見積もってしまう誤検出が原因である。その他、重

が小さくなり、ま

径分布

の形状は大きく異なっているものが見られる。特に粒子径の小さい方へ分布が引きずられた

ものが目立つので、粒子の面積や形状などのフィルタでノイズや異物を排除することも必要で

ことか

凝集が画像全体に多くなると、粒子重なり部及び粒子内部のコントラストにより、誤検出、誤

分割を生じる。輪郭を内側にとらないこと、誤分割、誤検出を減らすことによる改善が可能かを

に対して変更さ

、機械学習によ

、形状フィルタの条件を見

などの方

にいくつかの事例



 

 

を載せた。

 

②粒子径分布

各機関で画像解析して得られた最大ｆ

図

であり、画像

 

4-3-4.

確認された。凝集が多い画像解析では、粒子のセグメンテーションが不十分であったり、微小

コントラストを粒子と誤認しまったり、凝集粒子の分

られたと考えられる。これら箇所

を減少することができた。

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

を載せた。 

②粒子径分布 

各機関で画像解析して得られた最大ｆ

図 14 に示す。

であり、画像 A,B

 

4.まとめ 

精度の高い粒子径分布を得るためには、ある程度凝集の少ない画像が必要であることが

確認された。凝集が多い画像解析では、粒子のセグメンテーションが不十分であったり、微小

コントラストを粒子と誤認しまったり、凝集粒子の分

られたと考えられる。これら箇所

を減少することができた。
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各機関で画像解析して得られた最大ｆ

示す。円相当径の平均値は、

62.0±

A,B と同程度にできることがわかった。

精度の高い粒子径分布を得るためには、ある程度凝集の少ない画像が必要であることが

確認された。凝集が多い画像解析では、粒子のセグメンテーションが不十分であったり、微小

コントラストを粒子と誤認しまったり、凝集粒子の分

られたと考えられる。これら箇所

を減少することができた。 
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各機関で画像解析して得られた最大ｆ

円相当径の平均値は、 

±2.1 (1σ) (nm

同程度にできることがわかった。

精度の高い粒子径分布を得るためには、ある程度凝集の少ない画像が必要であることが

確認された。凝集が多い画像解析では、粒子のセグメンテーションが不十分であったり、微小

コントラストを粒子と誤認しまったり、凝集粒子の分

られたと考えられる。これら箇所を手動で取り除く
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各機関で画像解析して得られた最大ｆeret 径、最小

 

nm) 

同程度にできることがわかった。

精度の高い粒子径分布を得るためには、ある程度凝集の少ない画像が必要であることが

確認された。凝集が多い画像解析では、粒子のセグメンテーションが不十分であったり、微小

コントラストを粒子と誤認しまったり、凝集粒子の分割がうまくいかず

を手動で取り除く、フィルタ条件を
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径、最小 feret 径及び円相当径

同程度にできることがわかった。 

精度の高い粒子径分布を得るためには、ある程度凝集の少ない画像が必要であることが

確認された。凝集が多い画像解析では、粒子のセグメンテーションが不十分であったり、微小

割がうまくいかず

、フィルタ条件を
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径及び円相当径の粒径分布結果

精度の高い粒子径分布を得るためには、ある程度凝集の少ない画像が必要であることが

確認された。凝集が多い画像解析では、粒子のセグメンテーションが不十分であったり、微小

割がうまくいかず、見かけ上小さな値が得

、フィルタ条件を変更することなどにバラツキ
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の粒径分布結果

精度の高い粒子径分布を得るためには、ある程度凝集の少ない画像が必要であることが

確認された。凝集が多い画像解析では、粒子のセグメンテーションが不十分であったり、微小

見かけ上小さな値が得

ことなどにバラツキ
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の粒径分布結果を

精度の高い粒子径分布を得るためには、ある程度凝集の少ない画像が必要であることが

確認された。凝集が多い画像解析では、粒子のセグメンテーションが不十分であったり、微小

見かけ上小さな値が得

ことなどにバラツキ



 

 

機関 解析ソフト

a 変更なし

b 変更なし

c ImageJ

e

g

・R version 3.3.1

・EBImage v4.16.0

　- Image

processing and

analysis for R

h

Image-Pro Premier

Ver.9.2

Photoshop CS

i

j

Fiji 1.0 (ImageJ

1.51n)

Waka

segmentation

(v3.2.21)

変更なし

 

 

 

※ 機関

 

 

 

 

 

 

 

 

 

 

 

解析ソフト 処理内容

変更なし
OpenCV

さらに、

変更なし

1.粒子解析ソフトにより粒子領域自動選択
2.粒子解析ソフトにより接触粒子の切り離し

（手動）

ImageJ　1.51s

1.Waka segmentation v3.2.20

Gui上で前景と背景を画像に上書きする要領で指定

し、処理する事で分離。

粒子分離処理

R version 3.3.1

EBImage v4.16.0

- Image

processing and

analysis for R

・ノイズ低減：

・セグメンテーション
distmap - 

propagate - 

粒径算出：

Image-Pro Premier

Ver.9.2

Photoshop CS

画像前処理、輪郭抽出、

①バンドパスフィルターローサイズ：
5，強さ：

②二値化①の画像を

③画像修正元画像
8bitグレー

（粒子間の分割を容易にするための画像処理）

Fiji 1.0 (ImageJ

segmentation

(v3.2.21)

・画像前処理
BG除去
Bilateral filter (spatial radius 3px, range radius 50

px)

・セグメンテーション
SiO2_007

子,BG

用し解析
・画像二値化
Probability map

で多値化、その後二値化

変更なし

機関 d,f は、再解析未実施
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処理内容
OpenCVを使ってWatershed

さらに、境界をFuijiでWatershed

粒子解析ソフトにより粒子領域自動選択

粒子解析ソフトにより接触粒子の切り離し

（手動）

1.Waka segmentation v3.2.20

上で前景と背景を画像に上書きする要領で指定

し、処理する事で分離。                                       2.

粒子分離処理　Image J

・ノイズ低減：Opening - 5pixel

・セグメンテーション
distmap - 距離マップから
propagate - 距離と輝度勾配の

粒径算出：computeFeatures

画像前処理、輪郭抽出、

①バンドパスフィルターローサイズ：

，強さ：100，回数：1（IPP

②二値化①の画像を2値化（

③画像修正元画像×②の画像（

グレー

（粒子間の分割を容易にするための画像処理）

・画像前処理
除去 (Rolling ball radius 80 px)

Bilateral filter (spatial radius 3px, range radius 50

・セグメンテーション
SiO2_007を用いてclassifier

,BG共に40,000 px程度）、これを全ての画像に適

用し解析
・画像二値化
Probability mapをStatistical region merging (Q=4)

で多値化、その後二値化

表 2. 画像 C

は、再解析未実施
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Watershedで分離
Watershedで分離

粒子解析ソフトにより粒子領域自動選択

粒子解析ソフトにより接触粒子の切り離し

1.Waka segmentation v3.2.20

上で前景と背景を画像に上書きする要領で指定
                                       2.

Image JのWatershed

Opening - 5pixel

距離マップからseed作成 閾値 0.3

距離と輝度勾配のtrade-off 0.001

computeFeatures

画像前処理、輪郭抽出、1次粒子以外の除去

①バンドパスフィルターローサイズ：5，ハイサイズ：
IPP）

値化（Photoshop）

②の画像（Photoshop

（粒子間の分割を容易にするための画像処理）

 (Rolling ball radius 80 px)

Bilateral filter (spatial radius 3px, range radius 50

classifierをトレーニング

程度）、これを全ての画像に適

Statistical region merging (Q=4)

で多値化、その後二値化

変更なし

C の再解析方法

は、再解析未実施 
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輪郭抽出の方式

粒子解析ソフトにより粒子領域自動選択

粒子解析ソフトにより接触粒子の切り離し 手動2値化処理

上で前景と背景を画像に上書きする要領で指定
                                       2.

 0.3近傍
trade-off 0.001

EBImage paintObjects

次粒子以外の除去

，ハイサイズ：

Photoshop）　→

（粒子間の分割を容易にするための画像処理）

Bilateral filter (spatial radius 3px, range radius 50

をトレーニング(粒

程度）、これを全ての画像に適

Statistical region merging (Q=4)

ImageJ Particle Analysis

の再解析方法 （表 1 の方法との変更点

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

輪郭抽出の方式

変更なし

値化処理

変更なし

EBImage paintObjects

変更なし

ImageJ Particle Analysis

の方法との変更点

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

フィルタ条件

円形度が0.85以上の粒子を抽出

写真端部で切れた粒子と
ラストは計測対象外

面積　215nm
2

・サイズfilter

　面積500pixel

・顕著な凹形(ヒョウタン形等

・画像の端(エッジ

一次粒子以外の除去

面積 ＜300nm

・形状フィルタリング：
周長＞K*2*√（

同面積の円周のＫ倍よりも大きな周長の粒子を
排除　Ｋ＝1.15

誤検出粒子の手動除去

の方法との変更点を記載）
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以上の粒子を抽出

写真端部で切れた粒子とノイズと考えられるコント
ラストは計測対象外

2
以下の粒子を排除

500pixel以下の粒子

ヒョウタン形等)を目視により削除

エッジ)に接触する粒子は削除

一次粒子以外の除去

300nm
2
 の粒子を排除

・形状フィルタリング：
√（π* 面積）の粒子を排除

同面積の円周のＫ倍よりも大きな周長の粒子を
1.15

誤検出粒子の手動除去

を記載） 
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ノイズと考えられるコント

以下の粒子を排除

を目視により削除

に接触する粒子は削除

面積）の粒子を排除

同面積の円周のＫ倍よりも大きな周長の粒子を

 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(a) 各機関の最大フェレ径
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各機関の最大フェレ径

図

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

各機関の最大フェレ径  (b) 各機関の円相当径

図 14. 画像 C
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各機関の円相当径

C の再解析後の

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

各機関の円相当径  (c) 

の再解析後の粒子径分布
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(c) 各機関の最小フェレ径

分布 

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

各機関の最小フェレ径 

a 

b 

c 

e 

g 

h 

i 

j 
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5.プロトコル

  4 章

5.1.試料調製

   ①ナノ粒子分散液を準備する。

   ②基板

   ③

   ④基板の親水化処理を行う。

   ⑤

     

     

   ⑥

     

      

    

⑦室温で乾燥させる。

⑧

⑨

 

5.2. SEM

①

②

③

④

プロトコル 

章で検討した結果から、推奨されるプロトコルを以下に示す。

試料調製 

①ナノ粒子分散液を準備する。

②基板（シリコン、

③滴下時の下敷きとして、および、

④基板の親水化処理を行う。

⑤ピペットなどで分散液を

 シリカなど基板への付着力が弱い粉体の場合、⑤を実施する前に、以下の添加剤を含む溶

液を準備し、分散液に添加する。この添加剤は分散剤が乾燥する間に粒子が凝集するのを

防ぐとともに、粒子が基板に付着するのを助けると考えられる。

  ・HEC（ヒドロキシエチルセルロース）

振盪や湯煎すると良い。

   基板に

   ・基板が

（7-8μ

⑥滴下後、濾紙を用いて分散液を吸い取る。

     チタニアなど凝集性が高い場合は、分散液が乾燥中する間に粒子が凝集するのを防ぐた

めにこの操作を入れる。以下の条件が良い。

・滴下後、すぐに吸い取る。１０秒程度の時間が目安である。

  ・濃度が高い場合は、上から被せるように吸い取り、濃度が希薄な場合は、横から

       吸い取るのが良い。

⑦室温で乾燥させる。

⑧導電コートは必要があれば施す

⑨上記、試料調整

SEM 観察 

①調製した試料を

マニュアルに従う。

②予備観察を行い、粒子が著しい局在がなく

まかな粒子径

③微小粒子も十分なコントラストが得られるよう加速電圧他、条件を調製する。

④計測用画像を撮影する

・撮影する SEM

・できるだけ粒子がランダムに存在する視野を選択

・後の画像解析のため
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で検討した結果から、推奨されるプロトコルを以下に示す。

①ナノ粒子分散液を準備する。

（シリコン、TEM グリッド

滴下時の下敷きとして、および、

④基板の親水化処理を行う。

ピペットなどで分散液を④

シリカなど基板への付着力が弱い粉体の場合、⑤を実施する前に、以下の添加剤を含む溶

液を準備し、分散液に添加する。この添加剤は分散剤が乾燥する間に粒子が凝集するのを

防ぐとともに、粒子が基板に付着するのを助けると考えられる。

（ヒドロキシエチルセルロース）

振盪や湯煎すると良い。

基板に TEM グリッドを使用する場合は、

基板が TEM グリッドの場合、滴下時に、

μm）が良い。 

滴下後、濾紙を用いて分散液を吸い取る。

チタニアなど凝集性が高い場合は、分散液が乾燥中する間に粒子が凝集するのを防ぐた

めにこの操作を入れる。以下の条件が良い。

滴下後、すぐに吸い取る。１０秒程度の時間が目安である。

・濃度が高い場合は、上から被せるように吸い取り、濃度が希薄な場合は、横から

吸い取るのが良い。

⑦室温で乾燥させる。30 分以上、自然乾燥するのが良い。

は必要があれば施す

試料調整条件、方法と

試料を治具に固定し、

マニュアルに従う。 

予備観察を行い、粒子が著しい局在がなく

粒子径分布を把握する。

微小粒子も十分なコントラストが得られるよう加速電圧他、条件を調製する。

計測用画像を撮影する。

SEM 画像のピクセルサイズは

できるだけ粒子がランダムに存在する視野を選択

後の画像解析のため、必要な対象粒子数を考慮し
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で検討した結果から、推奨されるプロトコルを以下に示す。

①ナノ粒子分散液を準備する。（濃度の目安は

グリッド）を用意する。

滴下時の下敷きとして、および、滴下後の分散液を吸い取るための濾紙を用意する。

④基板の親水化処理を行う。 

④の処理を施した基板に約

シリカなど基板への付着力が弱い粉体の場合、⑤を実施する前に、以下の添加剤を含む溶

液を準備し、分散液に添加する。この添加剤は分散剤が乾燥する間に粒子が凝集するのを

防ぐとともに、粒子が基板に付着するのを助けると考えられる。

（ヒドロキシエチルセルロース）

振盪や湯煎すると良い。） 

グリッドを使用する場合は、

グリッドの場合、滴下時に、

 

滴下後、濾紙を用いて分散液を吸い取る。

チタニアなど凝集性が高い場合は、分散液が乾燥中する間に粒子が凝集するのを防ぐた

めにこの操作を入れる。以下の条件が良い。

滴下後、すぐに吸い取る。１０秒程度の時間が目安である。

・濃度が高い場合は、上から被せるように吸い取り、濃度が希薄な場合は、横から

吸い取るのが良い。 

分以上、自然乾燥するのが良い。

は必要があれば施す。 

条件、方法と実施日

固定し、試料台

予備観察を行い、粒子が著しい局在がなく

分布を把握する。 

微小粒子も十分なコントラストが得られるよう加速電圧他、条件を調製する。

。 

画像のピクセルサイズは

できるだけ粒子がランダムに存在する視野を選択

、必要な対象粒子数を考慮し
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で検討した結果から、推奨されるプロトコルを以下に示す。

（濃度の目安は 0.1w

）を用意する。 

滴下後の分散液を吸い取るための濾紙を用意する。

の処理を施した基板に約

シリカなど基板への付着力が弱い粉体の場合、⑤を実施する前に、以下の添加剤を含む溶

液を準備し、分散液に添加する。この添加剤は分散剤が乾燥する間に粒子が凝集するのを

防ぐとともに、粒子が基板に付着するのを助けると考えられる。

（ヒドロキシエチルセルロース）1wt%水溶液を作製する。

グリッドを使用する場合は、2-5uL/mL

グリッドの場合、滴下時に、下に敷く濾紙は定量濾紙の目の粗いもの

滴下後、濾紙を用いて分散液を吸い取る。 

チタニアなど凝集性が高い場合は、分散液が乾燥中する間に粒子が凝集するのを防ぐた

めにこの操作を入れる。以下の条件が良い。 

滴下後、すぐに吸い取る。１０秒程度の時間が目安である。

・濃度が高い場合は、上から被せるように吸い取り、濃度が希薄な場合は、横から

分以上、自然乾燥するのが良い。

実施日を記録しておく

試料台にセットする。

予備観察を行い、粒子が著しい局在がなく分散されていること

微小粒子も十分なコントラストが得られるよう加速電圧他、条件を調製する。

画像のピクセルサイズは 1.5 nm/px 

できるだけ粒子がランダムに存在する視野を選択

、必要な対象粒子数を考慮し
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で検討した結果から、推奨されるプロトコルを以下に示す。 

0.1wt%） 

滴下後の分散液を吸い取るための濾紙を用意する。

の処理を施した基板に約 1μL 滴下する。

シリカなど基板への付着力が弱い粉体の場合、⑤を実施する前に、以下の添加剤を含む溶

液を準備し、分散液に添加する。この添加剤は分散剤が乾燥する間に粒子が凝集するのを

防ぐとともに、粒子が基板に付着するのを助けると考えられる。

水溶液を作製する。

5uL/mL の量を目安にするのが良い。

下に敷く濾紙は定量濾紙の目の粗いもの

チタニアなど凝集性が高い場合は、分散液が乾燥中する間に粒子が凝集するのを防ぐた

滴下後、すぐに吸い取る。１０秒程度の時間が目安である。

・濃度が高い場合は、上から被せるように吸い取り、濃度が希薄な場合は、横から

分以上、自然乾燥するのが良い。 

を記録しておくことが好ましい

にセットする。SEM 操作方法は、使用する装置の

されていること

微小粒子も十分なコントラストが得られるよう加速電圧他、条件を調製する。

1.5 nm/px 以下とする。

できるだけ粒子がランダムに存在する視野を選択し、撮影する。

、必要な対象粒子数を考慮し、必要な画像数とする。
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滴下後の分散液を吸い取るための濾紙を用意する。

滴下する。 

シリカなど基板への付着力が弱い粉体の場合、⑤を実施する前に、以下の添加剤を含む溶

液を準備し、分散液に添加する。この添加剤は分散剤が乾燥する間に粒子が凝集するのを

防ぐとともに、粒子が基板に付着するのを助けると考えられる。 

水溶液を作製する。（溶けにくい場合

量を目安にするのが良い。

下に敷く濾紙は定量濾紙の目の粗いもの

チタニアなど凝集性が高い場合は、分散液が乾燥中する間に粒子が凝集するのを防ぐた

滴下後、すぐに吸い取る。１０秒程度の時間が目安である。 

・濃度が高い場合は、上から被せるように吸い取り、濃度が希薄な場合は、横から

ことが好ましい。 

操作方法は、使用する装置の

されていることを確認する。それと同時に大

微小粒子も十分なコントラストが得られるよう加速電圧他、条件を調製する。

以下とする。 

し、撮影する。 

、必要な画像数とする。
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滴下後の分散液を吸い取るための濾紙を用意する。 

シリカなど基板への付着力が弱い粉体の場合、⑤を実施する前に、以下の添加剤を含む溶

液を準備し、分散液に添加する。この添加剤は分散剤が乾燥する間に粒子が凝集するのを

溶けにくい場合は超音波

量を目安にするのが良い。

下に敷く濾紙は定量濾紙の目の粗いもの

チタニアなど凝集性が高い場合は、分散液が乾燥中する間に粒子が凝集するのを防ぐた

・濃度が高い場合は、上から被せるように吸い取り、濃度が希薄な場合は、横から 

操作方法は、使用する装置の

を確認する。それと同時に大

微小粒子も十分なコントラストが得られるよう加速電圧他、条件を調製する。 

、必要な画像数とする。 

 

 24 
Copyright © Nanotechnology Business Creation Initiative. All rights reserved 

 

シリカなど基板への付着力が弱い粉体の場合、⑤を実施する前に、以下の添加剤を含む溶

液を準備し、分散液に添加する。この添加剤は分散剤が乾燥する間に粒子が凝集するのを

は超音波 

 

下に敷く濾紙は定量濾紙の目の粗いもの   

チタニアなど凝集性が高い場合は、分散液が乾燥中する間に粒子が凝集するのを防ぐた

操作方法は、使用する装置の  

を確認する。それと同時に大



 

 

⑤

      

5

示す。

①

②

③

  

④

⑤

  

⑦

 

 必要な粒子数の目安は、

 それより多い粒子が好ましい。

⑤参考まで、以下の項目を記録しておく

・使用装置

・検出器名

・加速電圧

   ・リターディング電圧

・照射電流

・観察倍率

・倍率校正法（校正試料）

・観察実施日

・SEM 画像サイズ

・ピクセルサイズ

 

5-3. 画像解析

解析手順の詳細例は、

示す。 

①解析準備 

使用画像の選択、解析ソフト

使用するソフトウェアやアルゴリズムは任意とする

 

②画像前処理

バックグランド処理

③セグメンテーション

  接触粒子の輪郭線が内側に後退するのを避けるよう閾値などを設定する。

含まれる場合には、画像前処理、フィルタ処理や目視判定などでこれを除く。

④画像２値化

⑤輪郭抽出 

輪郭トレースは、自動

輪郭抽出は自動画像処理で行う。画像分割などの前処理は手動でも構わない。

得られた粒子輪郭に明らかな誤分割や誤検出が含まれないことを確認する。

 ⑥自動計測の場合にはサイズフィルタや二値化条件に起因する粒子の検出漏れがない

確認する。

る。 

⑦粒子径分布算出

  粒子数の目安は、

数による解析が望ましい。
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必要な粒子数の目安は、

それより多い粒子が好ましい。

以下の項目を記録しておく

使用装置 

検出器名 

加速電圧(試料入射時

リターディング電圧

照射電流 /pA 

観察倍率 

倍率校正法（校正試料）

観察実施日 

画像サイズ (pixel)

ピクセルサイズ (nm/pixel)

画像解析(粒子解析

解析手順の詳細例は、

 

使用画像の選択、解析ソフト

使用するソフトウェアやアルゴリズムは任意とする

画像前処理  

バックグランド処理の実施。

セグメンテーション 

接触粒子の輪郭線が内側に後退するのを避けるよう閾値などを設定する。

含まれる場合には、画像前処理、フィルタ処理や目視判定などでこれを除く。

画像２値化 

 

輪郭トレースは、自動 

輪郭抽出は自動画像処理で行う。画像分割などの前処理は手動でも構わない。

得られた粒子輪郭に明らかな誤分割や誤検出が含まれないことを確認する。

自動計測の場合にはサイズフィルタや二値化条件に起因する粒子の検出漏れがない

確認する。数落としがある場合には二段階処理等の対策を行い、数落としを最小限に抑え

分布算出 

の目安は、500 

数による解析が望ましい。
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必要な粒子数の目安は、粒子径分布が

それより多い粒子が好ましい。 

以下の項目を記録しておく

試料入射時) /kV 

 /kV 

倍率校正法（校正試料）、校正実施日

(pixel) 

(nm/pixel) 

粒子解析)   

解析手順の詳細例は、表 1,表２及び

使用画像の選択、解析ソフトウェアの準備

使用するソフトウェアやアルゴリズムは任意とする

の実施。 

接触粒子の輪郭線が内側に後退するのを避けるよう閾値などを設定する。

含まれる場合には、画像前処理、フィルタ処理や目視判定などでこれを除く。

 あるいは手動で行う。

輪郭抽出は自動画像処理で行う。画像分割などの前処理は手動でも構わない。

得られた粒子輪郭に明らかな誤分割や誤検出が含まれないことを確認する。

自動計測の場合にはサイズフィルタや二値化条件に起因する粒子の検出漏れがない

数落としがある場合には二段階処理等の対策を行い、数落としを最小限に抑え

500 個以上とする。

数による解析が望ましい。 
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分布が比較的シャープ

以下の項目を記録しておくことが好ましい

校正実施日 

表２及び付録を参照

ウェアの準備をする。

使用するソフトウェアやアルゴリズムは任意とする

接触粒子の輪郭線が内側に後退するのを避けるよう閾値などを設定する。

含まれる場合には、画像前処理、フィルタ処理や目視判定などでこれを除く。

あるいは手動で行う。 

輪郭抽出は自動画像処理で行う。画像分割などの前処理は手動でも構わない。

得られた粒子輪郭に明らかな誤分割や誤検出が含まれないことを確認する。

自動計測の場合にはサイズフィルタや二値化条件に起因する粒子の検出漏れがない

数落としがある場合には二段階処理等の対策を行い、数落としを最小限に抑え

とする。粒子径分布が広い粒子の場合は、より多くの粒子
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比較的シャープな場合で

ことが好ましい。 

を参照いただき、ここではポイントとなる内容を

をする。 

使用するソフトウェアやアルゴリズムは任意とする 

接触粒子の輪郭線が内側に後退するのを避けるよう閾値などを設定する。

含まれる場合には、画像前処理、フィルタ処理や目視判定などでこれを除く。

輪郭抽出は自動画像処理で行う。画像分割などの前処理は手動でも構わない。

得られた粒子輪郭に明らかな誤分割や誤検出が含まれないことを確認する。

自動計測の場合にはサイズフィルタや二値化条件に起因する粒子の検出漏れがない

数落としがある場合には二段階処理等の対策を行い、数落としを最小限に抑え

分布が広い粒子の場合は、より多くの粒子

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

な場合で 500 個程度である

、ここではポイントとなる内容を

接触粒子の輪郭線が内側に後退するのを避けるよう閾値などを設定する。

含まれる場合には、画像前処理、フィルタ処理や目視判定などでこれを除く。

輪郭抽出は自動画像処理で行う。画像分割などの前処理は手動でも構わない。

得られた粒子輪郭に明らかな誤分割や誤検出が含まれないことを確認する。

自動計測の場合にはサイズフィルタや二値化条件に起因する粒子の検出漏れがない

数落としがある場合には二段階処理等の対策を行い、数落としを最小限に抑え

分布が広い粒子の場合は、より多くの粒子
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個程度であるが

、ここではポイントとなる内容を

接触粒子の輪郭線が内側に後退するのを避けるよう閾値などを設定する。         

含まれる場合には、画像前処理、フィルタ処理や目視判定などでこれを除く。 

輪郭抽出は自動画像処理で行う。画像分割などの前処理は手動でも構わない。     

得られた粒子輪郭に明らかな誤分割や誤検出が含まれないことを確認する。 

自動計測の場合にはサイズフィルタや二値化条件に起因する粒子の検出漏れがない

数落としがある場合には二段階処理等の対策を行い、数落としを最小限に抑え

分布が広い粒子の場合は、より多くの粒子
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が 

、ここではポイントとなる内容を 

         

     

自動計測の場合にはサイズフィルタや二値化条件に起因する粒子の検出漏れがないか

数落としがある場合には二段階処理等の対策を行い、数落としを最小限に抑え

分布が広い粒子の場合は、より多くの粒子



 

 

⑧

   

画像

1 

1 

n 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

⑧解析について、以下の項目を

・解析ソフト

・輪郭抽出の方式

・自動処理内容

・計測粒子数

・撮影視野数

・個々の粒子データとして最大・最小

画像 No. 粒子 ID

1 

2 

500 
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解析について、以下の項目を

解析ソフト 

輪郭抽出の方式 

自動処理内容 

計測粒子数 

撮影視野数 

個々の粒子データとして最大・最小

ID 粒子 

X 座標 
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解析について、以下の項目を参考に、

個々の粒子データとして最大・最小

表 3

粒子 

Y座標 

Max.

(nm)
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参考に、記録しておくことが好ましい。

個々の粒子データとして最大・最小 Feret 径、面積、円相当径を求める。

3．データ表（例）

Max..Feret 径

(nm) 

Min. Feret

(nm)

 

 

・ 

・ 

・ 

 

 ・ 

・ 

・ 
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記録しておくことが好ましい。

径、面積、円相当径を求める。

．データ表（例） 

Min. Feret 径

(nm) 
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記録しておくことが好ましい。 

径、面積、円相当径を求める。

Area 

(nm2) 

Perimeter

(nm)
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径、面積、円相当径を求める。(表 3 参照

erimeter 

(nm) 
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参照) 



 

 

【おわりに

  シリカ

検討の

凝集の多い試料においても分布を改善することができた。

計測が

  推奨プロトコル及び事例を参考に

であると考えられ

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

おわりに】 

シリカ、チタニアナノ粒子を用いて、試料調製法から画像解析の検討を行った。試料調製は

討の余地はあるものの

凝集の多い試料においても分布を改善することができた。

計測が SEM によっても可能であることを示すことができた

推奨プロトコル及び事例を参考に

であると考えられ、
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、チタニアナノ粒子を用いて、試料調製法から画像解析の検討を行った。試料調製は

余地はあるものの、目標とすべき状態に近づけることはできた。画像解析法の検討から

凝集の多い試料においても分布を改善することができた。

によっても可能であることを示すことができた

推奨プロトコル及び事例を参考に

、本文書を役立てていただければ幸いである。
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、チタニアナノ粒子を用いて、試料調製法から画像解析の検討を行った。試料調製は

、目標とすべき状態に近づけることはできた。画像解析法の検討から

凝集の多い試料においても分布を改善することができた。

によっても可能であることを示すことができた

推奨プロトコル及び事例を参考にすることで、

役立てていただければ幸いである。

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

、チタニアナノ粒子を用いて、試料調製法から画像解析の検討を行った。試料調製は

、目標とすべき状態に近づけることはできた。画像解析法の検討から

凝集の多い試料においても分布を改善することができた。

によっても可能であることを示すことができた

することで、他材料のナノ粒子

役立てていただければ幸いである。
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、チタニアナノ粒子を用いて、試料調製法から画像解析の検討を行った。試料調製は

、目標とすべき状態に近づけることはできた。画像解析法の検討から

凝集の多い試料においても分布を改善することができた。この結果から、精度の良い

によっても可能であることを示すことができたと言える。

他材料のナノ粒子の計測に展開することが可能

役立てていただければ幸いである。 
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、チタニアナノ粒子を用いて、試料調製法から画像解析の検討を行った。試料調製は

、目標とすべき状態に近づけることはできた。画像解析法の検討から

この結果から、精度の良い

。 

の計測に展開することが可能
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、チタニアナノ粒子を用いて、試料調製法から画像解析の検討を行った。試料調製は

、目標とすべき状態に近づけることはできた。画像解析法の検討から

この結果から、精度の良い粒子径

の計測に展開することが可能
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、チタニアナノ粒子を用いて、試料調製法から画像解析の検討を行った。試料調製は 

、目標とすべき状態に近づけることはできた。画像解析法の検討から 

粒子径分布 

の計測に展開することが可能 



 

 

基板

1
エラスチックカーボン
メッシュ（ELS-C10）

2 TEMメッシュ

3 シリコンウェハー

4 シリコンウェハー

5 シリコン

6
シリコンウェハー
（鏡面）

7 シリコン

8
TEMグリッド（フォル
ムバール支持膜）

 

A.シリカの場合の

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

基板
エラスチックカーボン
メッシュ（ELS-C10）

分散液2ml中にHEC1%水溶液
を　5μ
間）

TEMメッシュ HECを添加

シリコンウェハー 1%HEC水溶液を添加

シリコンウェハー HEC1%水溶液を約0.4%添加

分散液　40mlに1％HEC水溶液
を数滴添加、超音波分散

シリコンウェハー １％HEC水溶液を添加：
3μL/mL

1％ HEC水溶液をシリカ分散液
に添加

TEMグリッド（フォル
ムバール支持膜）

1%HEC水溶液を添加 (3µ
L/mL)

シリカの場合の

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

分散液に添加
分散液2ml中にHEC1%水溶液

μl添加（超音波分散10分

HECを添加

1%HEC水溶液を添加

HEC1%水溶液を約0.4%添加

分散液　40mlに1％HEC水溶液
を数滴添加、超音波分散

１％HEC水溶液を添加：
3μL/mL

1％ HEC水溶液をシリカ分散液
に添加

1%HEC水溶液を添加 (3µ

シリカの場合の試料調製法、観察条件、画像処理法
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基板前処理
分散液2ml中にHEC1%水溶液

l添加（超音波分散10分
DCプラズマ

HEC1%水溶液を約0.4%添加

親水化処理
2min
（JEOL DATUM：
HDT-400）

分散液　40mlに1％HEC水溶液
を数滴添加、超音波分散

親水化処理

１％HEC水溶液を添加： UVオゾン処理
15分

1％ HEC水溶液をシリカ分散液
親水化処理

1%HEC水溶液を添加 (3µ

付録

試料調製法、観察条件、画像処理法
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基板前処理 分散液滴下と後処理
DCプラズマ

分散液を接触

基板に滴下

分散液を数uL滴下

親水化処理

（JEOL DATUM：
HDT-400）

ガラス毛細管ピペットで約1
μL滴下、滴下10秒後濾紙
で分散液を除去

親水化処理
Si基板上に滴下、ブロアー
で表面の溶液を除去

UVオゾン処理 1μL滴下、10秒後　濾紙
で吸い取る

親水化処理
滴下後、余剰分散液を濾
紙で吸い取り

ろ紙の上に基板を乗せ、滴
下

付録 （事例集）

試料調製法、観察条件、画像処理法

表 A.1 
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分散液滴下と後処理

分散液を接触

基板に滴下

分散液を数uL滴下

ガラス毛細管ピペットで約1
L滴下、滴下10秒後濾紙

で分散液を除去

Si基板上に滴下、ブロアー
で表面の溶液を除去

L滴下、10秒後　濾紙
で吸い取る

滴下後、余剰分散液を濾
紙で吸い取り

ろ紙の上に基板を乗せ、滴

（事例集） 

試料調製法、観察条件、画像処理法 

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

分散液滴下と後処理 乾燥法

一昼夜
真空乾燥

分散液(0.1wt)を超音波分散処
理　　　　　　　　　　（10分間）

自然乾燥 蒸着処理

自然乾燥

ガラス毛細管ピペットで約1
L滴下、滴下10秒後濾紙

自然乾燥

Si基板上に滴下、ブロアー
自然乾燥

濃度高で粒子が固まったため、
分散液(HEC添加）に蒸留水を入
れ、10倍希釈し、再度同じ処理

L滴下、10秒後　濾紙
室温乾燥

滴下後、余剰分散液を濾
自然乾燥

ろ紙の上に基板を乗せ、滴
室温乾燥
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その他処理

分散液(0.1wt)を超音波分散処
理　　　　　　　　　　（10分間）

蒸着処理

濃度高で粒子が固まったため、
分散液(HEC添加）に蒸留水を入
れ、10倍希釈し、再度同じ処理
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その他処理

分散液(0.1wt)を超音波分散処
理　　　　　　　　　　（10分間）

濃度高で粒子が固まったため、
分散液(HEC添加）に蒸留水を入
れ、10倍希釈し、再度同じ処理

              

                   

 

                    



 

 

解析ソフト (ver.)

1

Adobe社製　

住友金属テクノロジー社製
粒子解析（Ver3.5

2 LUZEX AP

3 Fiji (ImageJ 1.49m)

4 Image-Pro Premier Ver.9.2

5 Image-Pro Premier 3D 

6 VLFeat v0.9.20

7 ImageJ (1.50i)

8 SPIP version 6.6.3

ImageJ (1.50g)9

 

 

 

 

 

 

 

 

 

使用SEM装置（メーカー）

1 JSM-7800F (JEOL)

3 Merlin(Zeiss

4 日立 SU-8230

5
SU8200

(日立ハイテクノロジーズ）

6 JSM-7610F

7 日立S5500

8 GeminiSEM 500 (ZEISS)

 (ver.)

社製　Photshop（Ver7.0

住友金属テクノロジー社製
Ver3.5）

Fiji (ImageJ 1.49m)

Image-Pro Premier Ver.9.2

Image-Pro Premier 3D （9.2.1

VLFeat v0.9.20

ImageJ (1.50i)

SPIP version 6.6.3

ImageJ (1.50g)

装置（メーカー）

JSM-7800F (JEOL)

Merlin(Zeiss）

 SU-8230

日立ハイテクノロジーズ）

JSM-7610F

S5500

GeminiSEM 500 (ZEISS)
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輪郭抽出の方式

Ver7.0）

自動、手動（一部）

二値化画像処理

自動

自動

9.2.1）
自動
（多角形自動トレース）

自動

自動

自動

自動

検出器名

UED検出器

InLens

UPPER（レンズ内
2次電子検出器）

日立ハイテクノロジーズ）
Upper検出器（

SEI,上方検出器

ET検出器

GeminiSEM 500 (ZEISS) InLens-SE
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輪郭抽出の方式 処理の内容　　（自動の場合）

自動、手動（一部）

Photshop

（

解析により二値化→自動計測

二値化画像処理 手動（自動は輪郭がぼやけて抽出不可）

二値化
Min Variance

（多角形自動トレース）
エッジ部を指定するとそこからエッジ部に
沿って粒子を自動にトレースする
Quick Shift

実施した後、

ルタリングを行い、極端な凹図形、突起を
もつ図形、ほぼ矩形・台形の図形を削除
した
二値化
Threshold

 (

値との高さの差の

われる箇所に

定

二値化（手動で
watershed, 

加速電圧
(kV)

3

3

（レンズ内

次電子検出器）
2

検出器（SE) 5

上方検出器 5

3

3

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

処理の内容　　（自動の場合）

Photshop自動選択ツールより粒子抽出

（1部手動により粒子の切り離し）後、粒子

解析により二値化→自動計測

手動（自動は輪郭がぼやけて抽出不可）

二値化 > remove outlines > watershed

Min Variance

エッジ部を指定するとそこからエッジ部に
沿って粒子を自動にトレースする
Quick Shift法によりセグメンテーションを

実施した後、2次の形状モーメント値でフィ

ルタリングを行い、極端な凹図形、突起を
もつ図形、ほぼ矩形・台形の図形を削除
した
二値化, watershed, 

Threshold

 (注)閾値は自動設定（主たる平面と最大

値との高さの差の

われる箇所にAOI

定

二値化（手動でTH

watershed, 輪郭抽出

表.A.2 

 

 

 

表 A.3 

加速電圧 照射電流
(pA)

観察倍率

193

60

9

40

8

8

30
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処理の内容　　（自動の場合）

自動選択ツールより粒子抽出

部手動により粒子の切り離し）後、粒子

解析により二値化→自動計測

手動（自動は輪郭がぼやけて抽出不可）
 > remove outlines > watershed

エッジ部を指定するとそこからエッジ部に
沿って粒子を自動にトレースする

法によりセグメンテーションを

次の形状モーメント値でフィ

ルタリングを行い、極端な凹図形、突起を
もつ図形、ほぼ矩形・台形の図形を削除

, watershed, 輪郭抽出

閾値は自動設定（主たる平面と最大

値との高さの差の20％）,単独の粒子と思
AOI（Area Of Interest

TH決定），despecle,

輪郭抽出

観察倍率 倍率校正法

x70,000 メーカーにて実施

x25,000
標準マイクロスケール
HJ-1000

x30,000 Cristal Dimennsion

x35,000 マイクロスケール

x80,000
社内基準のスケールを
使用

x50,000
Standard Microscale

Type 595-4706(

x50,000 ZEISS
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計測粒子数

自動選択ツールより粒子抽出

部手動により粒子の切り離し）後、粒子

手動（自動は輪郭がぼやけて抽出不可）

  > remove outlines > watershed 

エッジ部を指定するとそこからエッジ部に
沿って粒子を自動にトレースする

法によりセグメンテーションを

次の形状モーメント値でフィ

ルタリングを行い、極端な凹図形、突起を
もつ図形、ほぼ矩形・台形の図形を削除

閾値は自動設定（主たる平面と最大

単独の粒子と思
Area Of Interest）を設

despecle,

倍率校正法

メーカーにて実施

標準マイクロスケール
HJ-1000

Cristal Dimennsion

マイクロスケール

社内基準のスケールを

Standard Microscale

Type 595-4706(日立）
ZEISS社標準の方法
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計測粒子数 撮影視野数

1262

572

1042

767

750

1430

508

847

3470

9923

画像サイズ
(pixel)

1280 x 960

標準マイクロスケール
4096 x 2820

5120 x 3840

2560 x 1920

社内基準のスケールを
1280 x 1024

Standard Microscale

日立）
2560 x 1920

社標準の方法 2048 x 1536
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撮影視野数 粒子数/視野

98

9

16

23

10

12

11

31

86

100

画像サイズ ピクセルサイズ
(nm/pixel)

1280 x 960

4096 x 2820

5120 x 3840

2560 x 1920

1280 x 1024

2560 x 1920

2048 x 1536

/視野

13

64

65

33

75

119

46

27

40

99

ピクセルサイズ

1.3

1.1

0.8

1.4

1.2

1.0

1.1



1

2

3

4

5

6

7

8

9

 

 

基板

1 シリコンウエハー

2 シリコン

3 シリコン

4 シリコン

5 シリコン

6
シリコンウエハー
（鏡面）

7 シリコン

8 シリコン

9
シリコンウエハー
（鏡面）

B チタニアの場合の

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

シリコンウエハー
プラズマ処理 

基板をエタノールに

濃硫酸と過酸化水素水

（容積比 4：1）に浸漬し、

加熱

親水化処理 2min

（JEOL DATUM

アルコール洗浄

シリコンウエハー UVオゾン処理　

親水化処理

親水化処理

シリコンウエハー プラズマ処理

チタニアの場合の

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

基板前処理
 　2分

基板をエタノールに24時間浸漬

濃硫酸と過酸化水素水(30%)の混合溶液

）に浸漬し、100℃・

 2min

JEOL DATUM：HDT-400）

アルコール洗浄

オゾン処理　15分

チタニアの場合の試料調製法、観察条件、画像処理法
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パスツールピペットで約

後、ろ紙で分散液を除去

時間浸漬 パスツールピペットで

滴下

の混合溶液

℃・10分間の

分散液をピペットで

紙で除去

ガラス毛細管ピペットで約

滴下

滴下

Si基板に試料を

散液除去

分散液を滴下　余剰分散液を濾紙で吸い取り

1µL滴下後、ブロアーで表面の溶液を除去

分散液を

で吸い取る

試料調製法、観察条件、画像処理法

表.B.1
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分散液滴下と後処理

パスツールピペットで約

後、ろ紙で分散液を除去

パスツールピペットでSi

滴下10秒後にろ紙で分散液を除去

分散液をピペットで 1 µ

紙で除去

ガラス毛細管ピペットで約

滴下10秒後濾紙で分散液を除去

滴下 10秒後、濾紙で吸い取る

基板に試料を1µL滴下、

散液除去

分散液を滴下　余剰分散液を濾紙で吸い取り

滴下後、ブロアーで表面の溶液を除去

分散液を1µL滴下．数秒後余剰分散液をろ紙

で吸い取る

試料調製法、観察条件、画像処理法

.B.1 試料調製法
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分散液滴下と後処理

パスツールピペットで約1µL滴下、滴下

後、ろ紙で分散液を除去

Si基板上に約1µL

秒後にろ紙で分散液を除去

 1 µL滴下し、10秒後に濾

ガラス毛細管ピペットで約1µL滴下

秒後濾紙で分散液を除去

秒後、濾紙で吸い取る

滴下、10秒後　濾紙で分

分散液を滴下　余剰分散液を濾紙で吸い取り

滴下後、ブロアーで表面の溶液を除去

滴下．数秒後余剰分散液をろ紙

試料調製法、観察条件、画像処理法 

試料調製法 
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乾燥法

滴下、滴下10秒
室温乾燥

µL滴下、
室温乾燥

秒後に濾

室温乾燥

室温乾燥

室温乾燥

秒後　濾紙で分 実験室雰囲気
で室温乾燥

分散液を滴下　余剰分散液を濾紙で吸い取り 自然乾燥

滴下後、ブロアーで表面の溶液を除去
自然乾燥

滴下．数秒後余剰分散液をろ紙
室温乾燥
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乾燥法 その他処理

室温乾燥

室温乾燥
導電コート　

室温乾燥

Pdの導電コート

（サンユー電子

室温乾燥

室温乾燥

実験室雰囲気
で室温乾燥

自然乾燥

自然乾燥
チタニア分散液（濃度

を超音波分散（

室温乾燥
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その他処理

導電コート　(10mA, 20秒

の導電コート

（サンユー電子 SC-MC）

チタニア分散液（濃度0.1％）

を超音波分散（5min）

秒)

％）



 

 

解析ソフト
1 MAC-View (ver.4)
2 Mac-View Ver.3

3
Abobe Photoshop (

二値化まで
4 Image-Pro Premier Ver.9.2
5 LUZEX AP

6

EDSION  v1.1

（セグメンテーション）
OpenCV  v2.4.8

(輪郭抽出、粒径算出）

7 ImageJ (1.50i)

8 SPIP version 6.6.3

9

Image-Pro Premier 3D 
10 ImageJ (1.50g)

 

 

 

 

 

 

 

 

使用装置

1
S-4800/

日立ハイテクノロジーズ

2 S-5500/

3 JSM-6320F/JEOL

4 SU-8230/

5 S-4800/

6 JSM-7610F/JEOL

7 日立S5500

8 GeminiSEM 500 (ZEISS)

9
SU8200 /

日立ハイテクノロジーズ

10 JSM-7100F/JEOL

解析ソフト (ver.)
MAC-View (ver.4)
Mac-View Ver.3
Abobe Photoshop (トレースから

二値化まで) ImageJ (1.50i)
Image-Pro Premier Ver.9.2
LUZEX AP
EDSION  v1.1

（セグメンテーション）
OpenCV  v2.4.8

輪郭抽出、粒径算出）

ImageJ (1.50i)

SPIP version 6.6.3

Image-Pro Premier 3D 
ImageJ (1.50g)

使用装置/メーカー

S-4800/

日立ハイテクノロジーズ

S-5500/日立

JSM-6320F/JEOL

SU-8230/日立

S-4800/日立

JSM-7610F/JEOL

S5500

GeminiSEM 500 (ZEISS)

SU8200 /

日立ハイテクノロジーズ

JSM-7100F/JEOL
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輪郭抽出の方式
手動
手動

トレースから
) ImageJ (1.50i) 手動

Image-Pro Premier Ver.9.2 自動
手動

輪郭抽出、粒径算出）

自動

自動

自動

Image-Pro Premier 3D （9.2.1）

自動
（多角形自動
トレース）
手動

検出器名

Upper検出器 (SE)

SE検出器

SE検出器

UPPER

(レンズ内2次電子

検出器)

SE(U)

SEI,　上方検出器

ET検出器

GeminiSEM 500 (ZEISS) InLens-SE

Upper検出器（SE)

LED検出器
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輪郭抽出の方式
手動
手動

手動
自動
手動

自動

自動

自動

自動
（多角形自動
トレース）
手動

表 B

表

加速電圧
/kV

 (SE) 3

2

5

次電子 2

2.5

　上方検出器 5

3

2.5

SE) 5

7

*)25.4µmの
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処理の内容（自動の場合）

Min Variance

Mean Shift法でセグメンテー

ションを実施した後、目視確認
により明らかな分割ミスの図形
を削除

二値化, watershed, 

Threshold

 (注)閾値は自動設定（主たる

平面と最大値との高さの差の
20％）,単独の粒子と思われる

箇所にAOI（Area Of Interest

を設定

エッジ部を指定するとそこから
エッジ部に沿って粒子を自動に
トレースする

B.2 SEM 観察条件

表 B.3 画像解析

照射電流
/pA

観察倍率

100000 x100,000

15000 x100,000

20 x150,000

9 x30,000

x100,000

8 x300,000

8 x50,000

30 x50,000

40 x35,000

74 x70,000

のCuメッシュを用いて
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処理の内容（自動の場合）

法でセグメンテー

ションを実施した後、目視確認
により明らかな分割ミスの図形

, watershed, 輪郭抽出

閾値は自動設定（主たる

平面と最大値との高さの差の
単独の粒子と思われる

Area Of Interest）

エッジ部を指定するとそこから
エッジ部に沿って粒子を自動に

観察条件 

画像解析 

観察倍率 倍率校正

x100,000 装置メーカー方法

x100,000 銅メッシュ/目開き

x150,000 ゲラー社 S2009ST

x30,000 Cristal Dimennsion

x100,000 グレーチング試料観察

x300,000 社内基準のスケールを使用

x50,000
Standard Microscale Type

595-4706（日立）

x50,000 ZEISS社  標準の方法

x35,000 マイクロスケール

x70,000 ISO16700準拠

メッシュを用いて1,000倍率で観察、装置の測長機能を使用して校正
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計測粒子数
586
517

777
1121
587

ションを実施した後、目視確認
により明らかな分割ミスの図形

324

輪郭抽出
503

閾値は自動設定（主たる

平面と最大値との高さの差の
単独の粒子と思われる

）

1199

エッジ部を指定するとそこから
エッジ部に沿って粒子を自動に

564
772

装置メーカー方法 ( * )

目開き25µm

 S2009ST

Cristal Dimennsion

グレーチング試料観察

社内基準のスケールを使用

Standard Microscale Type

（日立）

標準の方法

マイクロスケール

準拠 (MRS-6)

倍率で観察、装置の測長機能を使用して校正
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撮影視野数
586 25
517 10

777 15
1121 12
587 30

324 12

503 4

1199 30

564 11
772 34

画像サイズ
(pixel)

ピクセルサイズ

1280 x 960

1280 x 960

1024 x 768

5120 x 3840

2560 x 1920

1280 x1024

2560 x 1920

2048 x 1536

2560 x 1920

2560 x 1920

倍率で観察、装置の測長機能を使用して校正
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粒子数/視野
23
52

52
93
20

27

126

40

51
23

ピクセルサイズ
(nm/pixel)

0.99

1

0.83

0.82

0.5

0.31

1.01

1.1

1.42

0.67

倍率で観察、装置の測長機能を使用して校正



 

 

C. シリカの場合の粒

 

 

 

 

 

 

 

                                               

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

シリカの場合の粒
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シリカの場合の粒子径分布測定結果

                                               

図 C.1 粒径分布測定に使用したシリカ

図

表 A.3 の各解析事例に対応した結果を示している。
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0 20 40

Equivarent  circular diameter 

シリカ

径分布測定結果 

                                               

粒径分布測定に使用したシリカ

図 C.2  シリカ

の各解析事例に対応した結果を示している。
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40 60 80

Equivarent  circular diameter 

円相当径

 – SEM 像と粒子径分布

                                               

粒径分布測定に使用したシリカ

シリカの円相当径

の各解析事例に対応した結果を示している。
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80 100 120

Equivarent  circular diameter 

円相当径 粒径分布

像と粒子径分布 

                                                

粒径分布測定に使用したシリカの SEM

の円相当径の粒径分布

の各解析事例に対応した結果を示している。
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120 140 160

Equivarent  circular diameter (nm)

粒径分布

 – 

SEM 画像事例 

粒径分布 

の各解析事例に対応した結果を示している。 
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D.チタニアの場合の粒子径分布測定結果
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チタニアの場合の粒子径分布測定結果
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0
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0.6

0.8

1

0

)

チタニアの場合の粒子径分布測定結果

図 D.1  粒径分布測定に使用したチタニア

図

表 B.3 の各解析事例に対応した結果を示している。
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20 40

Equivarent  circular diameter 

チタニア

チタニアの場合の粒子径分布測定結果 

粒径分布測定に使用したチタニア

図 D.2  チタニア

の各解析事例に対応した結果を示している。
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60 80

Equivarent  circular diameter 

円相当径

 – SEM 像と粒子径分布

粒径分布測定に使用したチタニア

 

チタニアの円相当径

の各解析事例に対応した結果を示している。
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100 120

Equivarent  circular diameter 

粒径分布

像と粒子径分布

粒径分布測定に使用したチタニアの SEM

の円相当径の粒径分布

の各解析事例に対応した結果を示している。
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140 160

(nm)

粒径分布

像と粒子径分布 –  

SEM 画像事例 

粒径分布 

の各解析事例に対応した結果を示している。 
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E.画像解析

E.1  

  ------------------------------------------------------------------------------

1.1 

元画像をロード。

計測視野（

いた、観察視野部分）に

 

1.2 

上部メニューバー＞前処理＞強調＞ル

ックアップテーブル変換＞ガンマ補正

を選択し、ガンマ値を入力。

この機関の場合は

って

1.3 

上部メニューバー＞前処理＞強調＞＞

明るさ・コントラスト＞明るさ、コント

ラストを調整。

この機関の画像では明るさ

ラスト

5,コントラスト

 

 

画像解析詳細手順例

E.1   （本文 表

------------------------------------------------------------------------------

1.1 計測視野に

元画像をロード。

計測視野（SEM

いた、観察視野部分）に

1.2 γ値補正 

上部メニューバー＞前処理＞強調＞ル

ックアップテーブル変換＞ガンマ補正

を選択し、ガンマ値を入力。

この機関の場合は

って 0.3～0.5 を選択。

1.3 明るさ、コントラスト調整

上部メニューバー＞前処理＞強調＞＞

明るさ・コントラスト＞明るさ、コント

ラストを調整。

この機関の画像では明るさ

ラスト 10。各機関によって明るさ

コントラスト

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

手順例  

表 1 機関 e の詳細）

------------------------------------------------------------------------------

計測視野に ROI をかける

元画像をロード。長方形 ROI

SEM 像下のデータバーを除

いた、観察視野部分）に ROI

 

上部メニューバー＞前処理＞強調＞ル

ックアップテーブル変換＞ガンマ補正

を選択し、ガンマ値を入力。

この機関の場合は 0.5 入力。各機関によ

を選択。 

明るさ、コントラスト調整

上部メニューバー＞前処理＞強調＞＞

明るさ・コントラスト＞明るさ、コント

ラストを調整。 

この機関の画像では明るさ

。各機関によって明るさ

コントラスト 10～50 を選択。

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

の詳細） 

------------------------------------------------------------------------------

をかける 

ROI ツールで

像下のデータバーを除

ROI をかける。

上部メニューバー＞前処理＞強調＞ル

ックアップテーブル変換＞ガンマ補正

を選択し、ガンマ値を入力。 

入力。各機関によ

明るさ、コントラスト調整 

上部メニューバー＞前処理＞強調＞＞

明るさ・コントラスト＞明るさ、コント

この機関の画像では明るさ -20,コント

。各機関によって明るさ-20～

を選択。 

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

------------------------------------------------------------------------------

ツールで

像下のデータバーを除

をかける。 

上部メニューバー＞前処理＞強調＞ル

ックアップテーブル変換＞ガンマ補正

入力。各機関によ

上部メニューバー＞前処理＞強調＞＞

明るさ・コントラスト＞明るさ、コント

コント

～

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

------------------------------------------------------------------------------

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

------------------------------------------------------------------------------

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

------------------------------------------------------------------------------
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------------------------------------------------------------------------------ 

 



 

 

1.4 

上部メニューバー＞前処理＞フィルタ

＞平均化でフィルタサイズ

択。

1.5 

上部メニューバー＞前処理＞抽出＞自

動2

方法をモード法に設定。粒子部分だけが

選択される程度に閾値を調整。

1.6 

上部メニューバー＞前処理＞モフォロ

ジー＞円形分離を選択。

分離境界は直線状に分けられる。

 

 

 

1.4 平均化フィルタ

上部メニューバー＞前処理＞フィルタ

＞平均化でフィルタサイズ

択。 

1.5 自動二値化

上部メニューバー＞前処理＞抽出＞自

2値処理＞自動

方法をモード法に設定。粒子部分だけが

選択される程度に閾値を調整。

 円形分離 

上部メニューバー＞前処理＞モフォロ

ジー＞円形分離を選択。

分離境界は直線状に分けられる。

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

平均化フィルタ 

上部メニューバー＞前処理＞フィルタ

＞平均化でフィルタサイズ

自動二値化 

上部メニューバー＞前処理＞抽出＞自

値処理＞自動2値化＞しきい値決定

方法をモード法に設定。粒子部分だけが

選択される程度に閾値を調整。

 

上部メニューバー＞前処理＞モフォロ

ジー＞円形分離を選択。 

分離境界は直線状に分けられる。

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

上部メニューバー＞前処理＞フィルタ

＞平均化でフィルタサイズ 5＊5 を選

上部メニューバー＞前処理＞抽出＞自

値化＞しきい値決定

方法をモード法に設定。粒子部分だけが

選択される程度に閾値を調整。 

上部メニューバー＞前処理＞モフォロ

分離境界は直線状に分けられる。 

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

上部メニューバー＞前処理＞フィルタ

を選

 

上部メニューバー＞前処理＞抽出＞自

値化＞しきい値決定

方法をモード法に設定。粒子部分だけが

上部メニューバー＞前処理＞モフォロ

Copyright © Nanotechnology Business Creation Initiative. All rights reservedCopyright © Nanotechnology Business Creation Initiative. All rights reservedCopyright © Nanotechnology Business Creation Initiative. All rights reserved
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1.7

上部バーの消しゴムツールで自動抽出

の輪郭が不一致の箇所、円形分離が正し

くできていない粒子を目視で判断し手

動で除去

 

1.8 

上部メニューバー＞

ジー＞孤立点除去（除去対象：明るい点）

を選択

 

1.9 

上部メニューバー＞

キャリブレーションで

入力してキャリブレーション

1.10 

上部メニューバー＞編集＞計測環境＞

ボックスモード＞境界線上の物体を上

下左右の境界ごとに区別して処理する

＞上下左右すべて処理しないを選択

1.11 

上部メニューバー＞計測＞形状特徴＞

面積、絶対最大長、対角幅、周長、始点

を出力

 

1.7 誤検出粒子を手動で除去

上部バーの消しゴムツールで自動抽出

の輪郭が不一致の箇所、円形分離が正し

くできていない粒子を目視で判断し手

動で除去 

1.8 単粒子除去

上部メニューバー＞

ジー＞孤立点除去（除去対象：明るい点）

を選択 

1.9 キャリブレーション

上部メニューバー＞

キャリブレーションで

入力してキャリブレーション

1.10 視野の端の粒子を計測から除く

上部メニューバー＞編集＞計測環境＞

ボックスモード＞境界線上の物体を上

下左右の境界ごとに区別して処理する

＞上下左右すべて処理しないを選択

1.11 計測 

上部メニューバー＞計測＞形状特徴＞

面積、絶対最大長、対角幅、周長、始点

を出力 

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

誤検出粒子を手動で除去

上部バーの消しゴムツールで自動抽出

の輪郭が不一致の箇所、円形分離が正し

くできていない粒子を目視で判断し手

単粒子除去 

上部メニューバー＞2値処理＞モフォロ

ジー＞孤立点除去（除去対象：明るい点）

キャリブレーション 

上部メニューバー＞編集＞計測環境

キャリブレーションで 1pixcel

入力してキャリブレーション

視野の端の粒子を計測から除く

上部メニューバー＞編集＞計測環境＞

ボックスモード＞境界線上の物体を上

下左右の境界ごとに区別して処理する

＞上下左右すべて処理しないを選択

上部メニューバー＞計測＞形状特徴＞

面積、絶対最大長、対角幅、周長、始点
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誤検出粒子を手動で除去 

上部バーの消しゴムツールで自動抽出

の輪郭が不一致の箇所、円形分離が正し

くできていない粒子を目視で判断し手

値処理＞モフォロ

ジー＞孤立点除去（除去対象：明るい点）

編集＞計測環境＞

1pixcel の数値を

入力してキャリブレーション 

視野の端の粒子を計測から除く 

上部メニューバー＞編集＞計測環境＞

ボックスモード＞境界線上の物体を上

下左右の境界ごとに区別して処理する

＞上下左右すべて処理しないを選択 

上部メニューバー＞計測＞形状特徴＞

面積、絶対最大長、対角幅、周長、始点
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上部バーの消しゴムツールで自動抽出

の輪郭が不一致の箇所、円形分離が正し

くできていない粒子を目視で判断し手

値処理＞モフォロ

ジー＞孤立点除去（除去対象：明るい点）

＞

の数値を

 

 

上部メニューバー＞編集＞計測環境＞

ボックスモード＞境界線上の物体を上

下左右の境界ごとに区別して処理する

 

上部メニューバー＞計測＞形状特徴＞

面積、絶対最大長、対角幅、周長、始点
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E.2  

解析の準備

 使用する解析ソフト：

解析対象画像

 

1. 画像前処理

１．必要な領域を切り出し。

makeRectangle(0,

 

２．画像の平坦化。

run("Subtract

sliding");

３．ごま塩ノイズ等を減らす。

 

run("Median...",

or 

run(“

 

 

 

 

 （本文 表 1

解析の準備 

使用する解析ソフト：

解析対象画像: 

画像前処理 

１．必要な領域を切り出し。

makeRectangle(0,

２．画像の平坦化。

run("Subtract Background...",

sliding"); 

３．ごま塩ノイズ等を減らす。

run("Median...", 

 

run(“Despeckle");

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

1 機関 a の詳細）

使用する解析ソフト：imageJ (Fiji)

  粒状物 

 

１．必要な領域を切り出し。

makeRectangle(0, 0, 1280, 960);

２．画像の平坦化。 

Background...",

３．ごま塩ノイズ等を減らす。

 “radius=2"); 

Despeckle"); 

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

の詳細） 

imageJ (Fiji) 

１．必要な領域を切り出し。 

960); 

Background...", "rolling=100

３．ごま塩ノイズ等を減らす。 

 

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

imageJ (Fiji) 

"rolling=100 
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2. セグメンテーション

１．必要なら、

てみる。

２．もしくは手動。

 

3. 画像二値化

１．大津法で閾値を決め、二値化。

setAutoThreshold("Otsu

 

 

２．上手く行かない場合は他の方法で閾

値を決め、二値化。

 

setAutoThreshold("RenyiEntropy

セグメンテーション

１．必要なら、

てみる。 

２．もしくは手動。

画像二値化 

１．大津法で閾値を決め、二値化。

setAutoThreshold("Otsu

２．上手く行かない場合は他の方法で閾

値を決め、二値化。

setAutoThreshold("RenyiEntropy

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

セグメンテーション 

１．必要なら、opencv や機械学習等を試し

２．もしくは手動。 

 

１．大津法で閾値を決め、二値化。

setAutoThreshold("Otsu dark");

２．上手く行かない場合は他の方法で閾

値を決め、二値化。 

setAutoThreshold("RenyiEntropy

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

や機械学習等を試し

１．大津法で閾値を決め、二値化。 

dark"); 

２．上手く行かない場合は他の方法で閾

setAutoThreshold("RenyiEntropy dark"); 

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

や機械学習等を試し  

 

 

 

 

 

２．上手く行かない場合は他の方法で閾

 

Copyright © Nanotechnology Business Creation Initiative. All rights reservedCopyright © Nanotechnology Business Creation Initiative. All rights reservedCopyright © Nanotechnology Business Creation Initiative. All rights reserved

 

 38 
Copyright © Nanotechnology Business Creation Initiative. All rights reserved 



 

 

３．以上で

閾値を決め

 

setThreshold(46,

 

4. 粒子輪郭抽出

１．上記の二値化で不十分な場合は

watershed

run("Watershed");

 

 

２．もしく

３．

 

 

 

 

 

 

 

 

 

 

 

３．以上で上手くいかない

閾値を決め、二値化。

setThreshold(46,

粒子輪郭抽出

１．上記の二値化で不十分な場合は

watershed で境界を抽出。

run("Watershed");

２．もしくは opencv

３．上手くいかない場合は

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

上手くいかない

二値化。 

setThreshold(46, 255); 

粒子輪郭抽出 

１．上記の二値化で不十分な場合は

で境界を抽出。 

run("Watershed"); 

opencv や機械学習で検討。

上手くいかない場合は

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

上手くいかない場合は手動で

１．上記の二値化で不十分な場合は

 

や機械学習で検討。

上手くいかない場合は手動で抽出。

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

場合は手動で

１．上記の二値化で不十分な場合は

や機械学習で検討。  

手動で抽出。  
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E.3  

  ----------------------------------------------------------------------------

解析の準備

・基本的な操作については下を参照

・使用する

解析対象

本文書は右の様な比較的凝集度の高い

SiO2

RRT

粒径分布解析手順を各段階での画像を示し

ながら説明する。

なお、画像は

を使用し

 

 

  （本文 表 2 

----------------------------------------------------------------------------

解析の準備 

使用する解析ソフト：

・基本的な操作については下を参照

ImageJ.net

 http://imagej.net/Welcome

ImageJ 日本語情報

 http://seesaawiki.jp/w/imagej/

・使用する Fiji

Bilateral filter

Trainable Weka Segmentation

http://imagej.net/Trainable_Weka_Segmentation

Statistical 

http://imagej.net/Statistical_Region_Merging

 

解析対象 

本文書は右の様な比較的凝集度の高い

2 粒子画像からなる画像セット（画像解析

RRT データセット

粒径分布解析手順を各段階での画像を示し

ながら説明する。 

なお、画像は Fiji macOS

を使用した例である。

 

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

2 機関 j の詳細

----------------------------------------------------------------------------

 

使用する解析ソフト：Fiji (ImageJ) 

・基本的な操作については下を参照

ImageJ.net 

http://imagej.net/Welcome

日本語情報 

http://seesaawiki.jp/w/imagej/

Fiji プラグイン 

Bilateral filter 

Trainable Weka Segmentation

http://imagej.net/Trainable_Weka_Segmentation

Statistical Region Merging

http://imagej.net/Statistical_Region_Merging

本文書は右の様な比較的凝集度の高い

粒子画像からなる画像セット（画像解析

データセット f）を想定して、

粒径分布解析手順を各段階での画像を示し

 

Fiji macOS 版 ver. 2.0.0/1.51s

た例である。 

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

の詳細） 

----------------------------------------------------------------------------

Fiji (ImageJ)  

・基本的な操作については下を参照 

http://imagej.net/Welcome

 

http://seesaawiki.jp/w/imagej/

 

Trainable Weka Segmentation 

http://imagej.net/Trainable_Weka_Segmentation

Region Merging 

http://imagej.net/Statistical_Region_Merging

本文書は右の様な比較的凝集度の高い

粒子画像からなる画像セット（画像解析

）を想定して、Fiji を用いた

粒径分布解析手順を各段階での画像を示し

ver. 2.0.0/1.51s

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

----------------------------------------------------------------------------

 

http://imagej.net/Welcome 

http://seesaawiki.jp/w/imagej/ 

http://imagej.net/Trainable_Weka_Segmentation

http://imagej.net/Statistical_Region_Merging

本文書は右の様な比較的凝集度の高い

粒子画像からなる画像セット（画像解析

を用いた

粒径分布解析手順を各段階での画像を示し

ver. 2.0.0/1.51s

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

----------------------------------------------------------------------------

http://imagej.net/Trainable_Weka_Segmentation 

http://imagej.net/Statistical_Region_Merging 
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----------------------------------------------------------------------------
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----------------------------------------------------------------------------
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---------------------------------------------------------------------------- 

 



 

 

1. 画像前処理

1.1 画像のトリミング

Fiji(ImageJ)

ルで解析範囲を選択し、

Image > Crop

で字幕部を除去する。

1.2 Background 

上部メニューより

Process > Subtract background

 Rolling ball radius: 80 px

を実行し、バックグラウンドを除去する。

1.3 Bilateral filter

フィルタ処理により画像の平滑化を行う。

メニューの

Plug-

 Bilateral filter

を実行。パラメータは以下を入力。

  spatial radius: 3px

range radius: 50 px

得られた画像を

上記

画像前処理 

画像のトリミング

Fiji(ImageJ)で元画像をロード。

ルで解析範囲を選択し、

Image > Crop 

で字幕部を除去する。

1.2 Background 除去

上部メニューより 

Process > Subtract background

Rolling ball radius: 80 px

を実行し、バックグラウンドを除去する。

1.3 Bilateral filter 

フィルタ処理により画像の平滑化を行う。

メニューの 

-ins > Process >

Bilateral filter 

を実行。パラメータは以下を入力。

spatial radius: 3px

range radius: 50 px

得られた画像を Tiff

上記 1.の作業を全ての画像に対して実施する。

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

画像のトリミング 

で元画像をロード。

ルで解析範囲を選択し、 

で字幕部を除去する。 

除去 

 

Process > Subtract background

Rolling ball radius: 80 px 

を実行し、バックグラウンドを除去する。

 

フィルタ処理により画像の平滑化を行う。

ins > Process > 

を実行。パラメータは以下を入力。

spatial radius: 3px 

range radius: 50 px 

Tiff 形式で保存する。

の作業を全ての画像に対して実施する。

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

で元画像をロード。Rectangle

Process > Subtract background 

を実行し、バックグラウンドを除去する。 

フィルタ処理により画像の平滑化を行う。上部

を実行。パラメータは以下を入力。 

形式で保存する。 

の作業を全ての画像に対して実施する。

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

Rectangle ツー

フィルタ処理により画像の平滑化を行う。上部

の作業を全ての画像に対して実施する。 
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2. セグメンテーション

. 画像二値化

classifier

2.1 

1.3 で保存した画像を

部メニューの

Plug

 Trainable Weka Segmentation

を実行。

2.2 Classifier

教示データ作成

“ Polygon selection

selection

粒子に対応する範囲を選択し、”

class

より学習に使われる教示データが作成され

る。この例では背景が

class 2

2.3 Classifier

“Train classifier

を実行。学習に基づく

画像全体が薄い赤、緑に色分けされる。

2.4 Classifier

粒子を選択・分離ができるようになるまで、

教示データとなる領域を増やしながら

を繰り返す。各クラスのデータ数（ピクセル

数）は同じくらいとするのが良い。

各クラスのデータ数は

“# of pixels selected as class 1: xxxx

として表示される。

40,000 px 

セグメンテーション

画像二値化 1.3

classifier をトレーニング・画像解析を行い、背景から粒子を分離した

2.1 セグメンテーションプログラムを起動

で保存した画像を

部メニューの 

Plug-ins > Segmentation >

Trainable Weka Segmentation

を実行。 

2.2 Classifier のトレーニング

教示データ作成 

Polygon selection

selection”、”Freehand 

粒子に対応する範囲を選択し、”

class”ボタンで対応する

より学習に使われる教示データが作成され

る。この例では背景が

class 2（緑）。 

2.3 Classifier のトレーニング

Train classifier

を実行。学習に基づく

画像全体が薄い赤、緑に色分けされる。

2.4 Classifier のトレーニング

粒子を選択・分離ができるようになるまで、

教示データとなる領域を増やしながら

を繰り返す。各クラスのデータ数（ピクセル

数）は同じくらいとするのが良い。

各クラスのデータ数は

# of pixels selected as class 1: xxxx

として表示される。

40,000 px を教示データとして使用した。

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

セグメンテーション 

1.3 で保存した画像を１枚選択し、この画像を教示データとして用い

をトレーニング・画像解析を行い、背景から粒子を分離した

セグメンテーションプログラムを起動

で保存した画像を 1 枚開いた状態で、

ins > Segmentation > 

Trainable Weka Segmentation

のトレーニング(1)

 

Polygon selection ” や ”

Freehand Line”

粒子に対応する範囲を選択し、”

”ボタンで対応するclass

より学習に使われる教示データが作成され

る。この例では背景が class 1

のトレーニング(2)

Train classifier”ボタンでセグメンテーション

を実行。学習に基づくClassifier

画像全体が薄い赤、緑に色分けされる。

のトレーニング(3)

粒子を選択・分離ができるようになるまで、

教示データとなる領域を増やしながら

を繰り返す。各クラスのデータ数（ピクセル

数）は同じくらいとするのが良い。

各クラスのデータ数は log ウィンドウに

# of pixels selected as class 1: xxxx

として表示される。RRT では各クラス約

を教示データとして使用した。
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で保存した画像を１枚選択し、この画像を教示データとして用い

をトレーニング・画像解析を行い、背景から粒子を分離した

セグメンテーションプログラムを起動 

枚開いた状態で、

 

Trainable Weka Segmentation 

(1) 

” や ” Freehand 

” ツールで背景

粒子に対応する範囲を選択し、”Add to 

classに登録。これに

より学習に使われる教示データが作成され

class 1（赤）粒子が

(2) 

”ボタンでセグメンテーション

Classifierの判断により

画像全体が薄い赤、緑に色分けされる。 

(3) 

粒子を選択・分離ができるようになるまで、

教示データとなる領域を増やしながら 2.2, 2.3

を繰り返す。各クラスのデータ数（ピクセル

数）は同じくらいとするのが良い。 

ウィンドウに 

# of pixels selected as class 1: xxxx” 

では各クラス約

を教示データとして使用した。 
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で保存した画像を１枚選択し、この画像を教示データとして用い

をトレーニング・画像解析を行い、背景から粒子を分離した

 

枚開いた状態で、上

Freehand 

ツールで背景/

Add to 

に登録。これに

より学習に使われる教示データが作成され

（赤）粒子が

”ボタンでセグメンテーション

の判断により

 

粒子を選択・分離ができるようになるまで、

2.2, 2.3

を繰り返す。各クラスのデータ数（ピクセル

では各クラス約

 

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

で保存した画像を１枚選択し、この画像を教示データとして用い

をトレーニング・画像解析を行い、背景から粒子を分離した

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

で保存した画像を１枚選択し、この画像を教示データとして用い

をトレーニング・画像解析を行い、背景から粒子を分離した probability map

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

で保存した画像を１枚選択し、この画像を教示データとして用い trainable 

probability map を得る。
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trainable 

を得る。 

 

 

 

 



 

 

2.5 Probability map

“Get probability

を作成する。

のグレースケール画像が出力されるので、こ

れを

Probability map 

(Class 2)

している。

2.6 

トレーニングした

用 し

classifier

選択、”

segmentation?

選択した画像の

るのでこれを

この操作を繰り返し、全ての画像について

Probability map

解析対象となる画像の特徴が、トレーニング

に用いた画像と大きく異なると、解析が上手

くいかない場合がある。このような場合には

特徴の似た画像ごとにトレーニング・解析を

行うなどの処理が必要となる。

 

3. 画像二値化セグメンテーションで得られた

多値化してから二値化し、粒子輪郭抽出の為の準備を行う。

3.1 Probability map

2.で得た

部メニューの

Image > Type > 8

を選択し、画像を

2.5 Probability map

Get probability

を作成する。2 枚の画像がスタックした

のグレースケール画像が出力されるので、こ

れを tiff 形式で保存。

Probability map 

(Class 2)である確率をグレースケールで表示

している。 

2.6 他の画像の解析

トレーニングした

用 し Probability map

classifier” ボタンより、

選択、”Create probability maps instead

segmentation?”に対しては「

選択した画像の

るのでこれを tiff

この操作を繰り返し、全ての画像について

Probability map を得る。

解析対象となる画像の特徴が、トレーニング

に用いた画像と大きく異なると、解析が上手

くいかない場合がある。このような場合には

特徴の似た画像ごとにトレーニング・解析を

行うなどの処理が必要となる。

画像二値化セグメンテーションで得られた

多値化してから二値化し、粒子輪郭抽出の為の準備を行う。

3.1 Probability map

で得た probability map

部メニューの 

Image > Type > 8

を選択し、画像を

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

2.5 Probability map の作成 

Get probability”ボタンから

枚の画像がスタックした

のグレースケール画像が出力されるので、こ

形式で保存。 

Probability map はそのピクセルが

である確率をグレースケールで表示

他の画像の解析 

トレーニングした classifier を他の画像にも適

Probability map を 得 る 。 “

ボタンより、1.3 で保存した画像を

Create probability maps instead

”に対しては「Yes

選択した画像の Probability map

tiff で保存する。

この操作を繰り返し、全ての画像について

を得る。 

解析対象となる画像の特徴が、トレーニング

に用いた画像と大きく異なると、解析が上手

くいかない場合がある。このような場合には

特徴の似た画像ごとにトレーニング・解析を

行うなどの処理が必要となる。

画像二値化セグメンテーションで得られた

多値化してから二値化し、粒子輪郭抽出の為の準備を行う。

3.1 Probability map の 8 bit 化

probability map を開いた状態で

Image > Type > 8-bit 

を選択し、画像を 8bit 化する。
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”ボタンから Probability map

枚の画像がスタックした 32 bit

のグレースケール画像が出力されるので、こ

はそのピクセルが Class 1 

である確率をグレースケールで表示

を他の画像にも適

を 得 る 。 “ Apply 

で保存した画像を

Create probability maps instead

Yes」で進む。

Probability map が出力され

で保存する。 

この操作を繰り返し、全ての画像について

解析対象となる画像の特徴が、トレーニング

に用いた画像と大きく異なると、解析が上手

くいかない場合がある。このような場合には

特徴の似た画像ごとにトレーニング・解析を

行うなどの処理が必要となる。 

画像二値化セグメンテーションで得られた

多値化してから二値化し、粒子輪郭抽出の為の準備を行う。

化 

を開いた状態で上

化する。 
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map

32 bit

のグレースケール画像が出力されるので、こ

Class 1 

である確率をグレースケールで表示

を他の画像にも適

Apply 

で保存した画像を

Create probability maps instead of 

」で進む。 

が出力され

この操作を繰り返し、全ての画像について

解析対象となる画像の特徴が、トレーニング

に用いた画像と大きく異なると、解析が上手

くいかない場合がある。このような場合には

特徴の似た画像ごとにトレーニング・解析を

画像二値化セグメンテーションで得られた Probability 

多値化してから二値化し、粒子輪郭抽出の為の準備を行う。

上

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

Probability map を Statistical region merging

多値化してから二値化し、粒子輪郭抽出の為の準備を行う。 
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Statistical region merging
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Statistical region merging で一旦
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で一旦

 



 

 

3.2 Stack

上部メニューの

Image > Stacks > Stack to image

を実行し、

た probability map

粒子が黒く表示される方の画像

tiff 

3.3 

3.2

から

Plug

Region Merging

Q:4 

として実行。数段階にグレースケールで色

分けされた画像が

れを

Image > Type > 8

より

3.4 

閾値を選択し、上で得られた画像を二値化

する。

Image > Adjust > Threshold

より、右の閾値設定ウィンドウを表示する。

粒子は黒であるので、

のチェックを外し、下側のスライダーで適切

に上限を調節し

を二値化する。二値化した画像を

で保存する。

 

3.2 Stack の分割

上部メニューの 

Image > Stacks > Stack to image

を実行し、class 1 

probability map

粒子が黒く表示される方の画像

tiff 形式で保存する。

3.3 画像多値化 

3.2 で保存した画像に対して上部メニュー

から 

Plug-ins > Segmentation > Statistical 

Region Merging 

Q:4  

として実行。数段階にグレースケールで色

分けされた画像が

れを 3.1 同様に 

Image > Type > 8

より 8 bit 化する。

3.4 画像二値化 

閾値を選択し、上で得られた画像を二値化

する。 

Image > Adjust > Threshold

より、右の閾値設定ウィンドウを表示する。

粒子は黒であるので、

のチェックを外し、下側のスライダーで適切

に上限を調節し

を二値化する。二値化した画像を

で保存する。 
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の分割 

 

Image > Stacks > Stack to image

class 1 および class 2 

probability map に分割する。

粒子が黒く表示される方の画像

形式で保存する。 

 

で保存した画像に対して上部メニュー

ins > Segmentation > Statistical 

 

として実行。数段階にグレースケールで色

分けされた画像が 32 bit で出力される。こ

 

Image > Type > 8-bit 

化する。 

 

閾値を選択し、上で得られた画像を二値化

Image > Adjust > Threshold 

より、右の閾値設定ウィンドウを表示する。

粒子は黒であるので、”Dark background

のチェックを外し、下側のスライダーで適切

に上限を調節し”Apply”ボタンを押し画像

を二値化する。二値化した画像を

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

Image > Stacks > Stack to image 

class 2 の独立し

に分割する。 

粒子が黒く表示される方の画像(class 1)

で保存した画像に対して上部メニュー

ins > Segmentation > Statistical 

として実行。数段階にグレースケールで色

で出力される。こ

閾値を選択し、上で得られた画像を二値化

 

より、右の閾値設定ウィンドウを表示する。

”Dark background

のチェックを外し、下側のスライダーで適切

ボタンを押し画像

を二値化する。二値化した画像を tiff 形式

Copyright © Nanotechnology Business Creation Initiative. All rights reserved

の独立し

(class 1)を

で保存した画像に対して上部メニュー

ins > Segmentation > Statistical 

として実行。数段階にグレースケールで色

で出力される。こ

閾値を選択し、上で得られた画像を二値化

より、右の閾値設定ウィンドウを表示する。

”Dark background”

のチェックを外し、下側のスライダーで適切

ボタンを押し画像

形式
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4. 粒子輪郭抽出

ImageJ

4.1 

上部メニューの

Analyze > Set 

より、出力される測定量を設定する。右の

画像は

4.2 

上部メニューの

Analyze > Set Scale

よりピクセルサイズを設定する。右の画像

は RRT

場合によっては”

ピクセルサイズ情報を除去して、単純に

で出力させることもできる。この場合、最終

的な報告値の単位に注意する。

4.2 

上部メニューの

Analyze > Particles

より粒子解析を実行する。

Size, Circularity

タ、真円度フィルタであり、指定した範囲内

の粒子のみを検出する。サイズフィルタを

利用する場合には単位に注意する。

 

粒子輪郭抽出 

ImageJ のビルトイン機能を用いて粒子の輪郭抽出、粒径計測を行う。

4.1 測定項目の設定

上部メニューの 

Analyze > Set Measurements

より、出力される測定量を設定する。右の

画像は RRT の時の例。

4.2 ピクセルサイズの設定

上部メニューの 

Analyze > Set Scale

よりピクセルサイズを設定する。右の画像

RRT の時の例。

場合によっては”

ピクセルサイズ情報を除去して、単純に

で出力させることもできる。この場合、最終

的な報告値の単位に注意する。

4.2 粒子解析 

上部メニューの 

Analyze > Particles

より粒子解析を実行する。

Size, Circularity

タ、真円度フィルタであり、指定した範囲内

の粒子のみを検出する。サイズフィルタを

利用する場合には単位に注意する。
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のビルトイン機能を用いて粒子の輪郭抽出、粒径計測を行う。

測定項目の設定 

 

Measurements

より、出力される測定量を設定する。右の

の時の例。 

ピクセルサイズの設定 

 

Analyze > Set Scale 

よりピクセルサイズを設定する。右の画像

の時の例。 

場合によっては”Click to Remove Scale

ピクセルサイズ情報を除去して、単純に

で出力させることもできる。この場合、最終

的な報告値の単位に注意する。

 

Analyze > Particles 

より粒子解析を実行する。 

Size, Circularity はそれぞれサイズフィル

タ、真円度フィルタであり、指定した範囲内

の粒子のみを検出する。サイズフィルタを

利用する場合には単位に注意する。
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のビルトイン機能を用いて粒子の輪郭抽出、粒径計測を行う。

Measurements 

より、出力される測定量を設定する。右の

 

よりピクセルサイズを設定する。右の画像
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4.3 

解析処理が完了すると、粒子輪郭像、解

析結果表

れるので、必要に応じてこれらを保存す

る。 

 

.4 誤検出粒子の手動除去

粒子輪郭像を見ながら明らかな誤分割・誤

検出を除去する。

 

[表計算ソフト

4.3 で得られた解析結果表を

表計算ソフトで開き、輪郭像を見ながら誤

分割・誤検出された粒子を選別する。

[ROI Manager]

4.3

状態で、

対応する粒子輪郭が強調表示される。誤

分割・誤検出粒子は、

Delete

除去後、

選択し、”

についての解析結果が出力される。この結

果は

注意。事前に表を選択し上部メニューの

Results > Clear Results

で表の内容を消去しておくなどすると良

い。 

4.3 粒子解析結果の表示

解析処理が完了すると、粒子輪郭像、解

析結果表(Results)

れるので、必要に応じてこれらを保存す

 

誤検出粒子の手動除去

粒子輪郭像を見ながら明らかな誤分割・誤

検出を除去する。

表計算ソフト] 

で得られた解析結果表を

表計算ソフトで開き、輪郭像を見ながら誤

分割・誤検出された粒子を選別する。

[ROI Manager] 

4.3 で出力された輪郭像をアクティブにした

状態で、ROI Manager

対応する粒子輪郭が強調表示される。誤

分割・誤検出粒子は、

Delete”ボタンでこれを除く。誤検出粒子を

除去後、ROI Manager

選択し、”Measure

についての解析結果が出力される。この結

果は 4.3 の Results

注意。事前に表を選択し上部メニューの

Results > Clear Results

で表の内容を消去しておくなどすると良
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粒子解析結果の表示 

解析処理が完了すると、粒子輪郭像、解

(Results)、ROI manger

れるので、必要に応じてこれらを保存す

誤検出粒子の手動除去 

粒子輪郭像を見ながら明らかな誤分割・誤

検出を除去する。 

 

で得られた解析結果表を

表計算ソフトで開き、輪郭像を見ながら誤

分割・誤検出された粒子を選別する。

 

で出力された輪郭像をアクティブにした

ROI Manager のリストを選択すると

対応する粒子輪郭が強調表示される。誤

分割・誤検出粒子は、ROI Manager

”ボタンでこれを除く。誤検出粒子を

ROI Manager 上の全ての粒子を

Measure”ボタンで、これらの粒子

についての解析結果が出力される。この結

esults の表に追記されるので

注意。事前に表を選択し上部メニューの

Results > Clear Results 

で表の内容を消去しておくなどすると良
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で得られた解析結果表を Excel などの

表計算ソフトで開き、輪郭像を見ながら誤
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で出力された輪郭像をアクティブにした

のリストを選択すると

対応する粒子輪郭が強調表示される。誤

ROI Manager の”

”ボタンでこれを除く。誤検出粒子を

上の全ての粒子を

”ボタンで、これらの粒子

についての解析結果が出力される。この結

の表に追記されるので

注意。事前に表を選択し上部メニューの 

で表の内容を消去しておくなどすると良
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れるので、必要に応じてこれらを保存す

粒子輪郭像を見ながら明らかな誤分割・誤

などの

表計算ソフトで開き、輪郭像を見ながら誤

で出力された輪郭像をアクティブにした
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対応する粒子輪郭が強調表示される。誤

の”

”ボタンでこれを除く。誤検出粒子を

上の全ての粒子を

”ボタンで、これらの粒子

についての解析結果が出力される。この結
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ナノ材料の実用的計測評価

             -------------------------------------------------------
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一般社団法人

ナノ材料の実用的計測評価

-------------------------------------------------------

無断配布、

引用する場合は、必ず出展を明記願います。
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一般社団法人 ナノテクノロジービジネス推進協議会

社会受容・標準化委員会

ナノ材料の実用的計測評価

-------------------------------------------------------

無断配布、本書の改編、改ざん及び転売を禁じます。

引用する場合は、必ず出展を明記願います。

東京都千代田区神田駿河台

東京

03-3518

http://www.nbci.jp/
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2019 年 4 月

 

ナノテクノロジービジネス推進協議会

社会受容・標準化委員会

ナノ材料の実用的計測評価 WG / 粒径分布計測プロトコル

-------------------------------------------------------

本書の改編、改ざん及び転売を禁じます。

引用する場合は、必ず出展を明記願います。

 

〒101-0062

東京都千代田区神田駿河台

東京 YWCA 会館

3518-9811（代表）

http://www.nbci.jp/
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月 

ナノテクノロジービジネス推進協議会

社会受容・標準化委員会 

粒径分布計測プロトコル

-------------------------------------------------------

本書の改編、改ざん及び転売を禁じます。

引用する場合は、必ず出展を明記願います。

0062 

東京都千代田区神田駿河台 1-8-11

会館 3 階 

（代表） 

http://www.nbci.jp/ 
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ナノテクノロジービジネス推進協議会 

粒径分布計測プロトコル WG

-------------------------------------------------------

本書の改編、改ざん及び転売を禁じます。 

引用する場合は、必ず出展を明記願います。 
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